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Preface

Scope of Manual

This guide is designed to assist you in getting started with the use of NightSimTM.  Night-
Sim is a real-time NightStar RTTM tool that provides a graphical user interface to the
frequency-based scheduler and performance monitor services.

Structure of Manual

This manual consists of five chapters, four appendixes, a glossary, and an index. A brief
description of the chapters and appendixes is presented as follows.

• Chapter 1 introduces you to the concepts and components of NightSim, a
real-time tool that is part of the NightStarTM development environment.

• Chapter 2 provides an overview of the primary factors that need to be taken
into account prior to running NightSim on RedHawk Linux. 

• Chapter 3 explains the procedures for beginning and ending a NightSim
session and explains how to get help. 

• Chapter 4 describes the frequency-based scheduler and introduces the
components of NightSim’s Scheduler window.

• Chapter 5 describes the performance monitor and introduces the
components of NightSim’s Monitor window.

• Appendix A discusses the NightStar License Manager (NSLM) and how to
obtain and install licenses.  It also discusses approaches for dealing with a
firewall either on the system acting as the license server or on a system
hosting the NightStar RT tools.

• Appendix A discusses the format of configuration files used by NightSim
as well as the automatic conversion of configuration files created by Night-
Sim 2.4 and earlier versions.

• Appendix C presents the configurable X resources, NightStar resources,
and widget hierarchy for NightSim.

The glossary contains definitions of technical terms that are important to understanding
the concepts presented in this book.

The index contains an alphabetical reference to key terms and concepts and numbers of
pages where they occur in the text.
iii



NightSim RT User’s Guide
Syntax Notation

The following notation is used throughout this manual: 

italic Books, reference cards, and items that the user must specify appear
in italic type. Special terms may also appear in italics.

list bold User input appears in list bold type and must be entered exactly
as shown. Names of directories, files, commands, options and system
manual page references also appear in list bold type.

list Operating system and program output such as prompts and messages
and listings of files and programs appear in list type.

[  ] Brackets enclose command options and arguments that are optional.
You do not type the brackets if you choose to specify such options or
arguments

Referenced Publications

The following publications are referenced in this document:

0890514 NightBenchTM User’s Guide
0891082 Real-Time Clock and Interrupt Module User’s Guide
0898004 RedHawk LinuxTM User’s Guide
0898395 NightViewTM RT User’s Guide
0898398 NightTraceTM RT User’s Guide
0898458 NightSimTM RT User’s Guide
0898515 NightTuneTM RT User’s Guide
0898537 MAXAda for RedHawk Linux Reference Manual
iv
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Chapter 1Overview

1
1
1

This chapter introduces you to the concepts and components of NightSim, a real-time tool
that is part of the NightStar development environment. NightSim provides a graphical user
interface to the major functions associated with the frequency-based scheduler and the
performance monitor.

Overview of NightSim 1

NightSim allows you to perform the entire range of functions associated with frequency-
based scheduling.   You can perform the major functions of configuring a scheduler,
setting up a timing source, scheduling programs, saving and restoring a scheduler
configuration, running a simulation, and viewing scheduling data. The principal features
of the frequency-based scheduler are described in the section that follows. 

NightSim also allows you to perform the entire range of functions associated with the
performance monitor. You can perform the major functions of selecting a scheduler,
clearing existing performance monitor values, enabling and disabling performance
monitoring, including and excluding interrupt time, and viewing performance monitor
values. The principal features of the performance monitor are described in “Overview of
the Performance Monitor” (see p. 1-2).

In addition, NightSim supports the use of timing sources, including Distributed Interrupts
devices on the RCIM (Real-Time Clock and Interface Module) board.  An addition capa-
bility is NightSim's ability to configure a frequency-based scheduler on any system in
your network, not just the NightSim host.

NightSim is also integrated with other NightStar tools.  NightSim may be invoked directly
from the Tools menu of any NightStar RT tool, and NightSim provides access to every
other NightStar RT tool in the same way.  NightSim also provides the ability to schedule
your programs under the control of the NightView Source-Level Debugger, making it easy
to gain control of scheduled programs in order to set breakpoints or monitorpoints early on
in the execution of the program, before it attaches to the frequency based scheduler.

NightSim’s graphical user interface is based on the X Window SystemTM and
OSF/Motif.TM 

Overview of the Frequency-Based Scheduler 1

The frequency-based scheduler, or FBS, is a task synchronization mechanism that allows
you to run processes at specified frequencies. Frequencies can be based on high-resolution
clocks, an external interrupt source, or completion of a cycle. The frequency-based
1-1
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scheduler provides a mechanism for initiating processes at the specified frequency. The
processes are then scheduled via the standard  priority-based scheduler. 

When used in conjunction with the performance monitor, the FBS can be used to
determine the best way of allocating processors to various tasks for a particular
application. Chapter 4, “Using the Scheduler Window,” fully describes the features and
capabilities of the frequency-based scheduler. 

Overview of the Performance Monitor 1

The performance monitor is a mechanism that allows you to monitor use of the CPU by
processes that are scheduled on a frequency-based scheduler. The values obtained can help
in determining whether processes need to be redistributed among processors for improved
load balancing and processing efficiency. You can obtain performance monitor values by
process or processor and can specify whether time spent servicing interrupts should be
included or excluded from the values. The performance monitor also makes it possible to
monitor a processor’s idle time. By examining the amount of idle time on each processor,
you can identify the processors that have the lightest load and determine the additional
amount of CPU time that can be used for scheduling real-time processes. Chapter 5,
“Using the Monitor Window,” fully describes the features and capabilities of the perfor-
mance monitor.

Overview of the Graphical User Interface 1

NightSim’s graphical user interface has two major windows: the Scheduler window and
the Monitor window.  The Scheduler window provides access to the key operations associ-
ated with frequency-based scheduling. The Monitor window provides access to the key
operations associated with performance monitoring. An overview of each window is pro-
vided in the sections that follow.

The Scheduler Window 1

Figure 1-1 presents the Scheduler window. This window allows you to configure a
frequency-based scheduler; set up a timing source for it; schedule programs on it; start,
stop, and resume a simulation; and view scheduling data.
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Figure 1-1.  Scheduler Window

The Scheduler window also allows you to save a scheduler configuration to a file and to
open and save a configuration file that you have previously created. It shows whether the
window is active (associated with a scheduler that exists on the system) or inactive (not
associated with a scheduler that exists on the system) and whether the selected scheduler
is running or stopped. It displays the current minor cycle and current major frame for the
simulation, and it graphically shows the execution cycle for each process that is scheduled
on the scheduler.

Chapter 4, “Using the Scheduler Window,” provides a detailed explanation of each area of
the Scheduler window and provides reference information for all of the fields and controls
in each area.

The Monitor Window 1

Figure 1-2 presents the Monitor window. This window allows you to monitor the
performance of selected FBS-scheduled processes scheduled on one or more processors
on a selected scheduler. It allows you to display performance monitor values for selected
FBS-scheduled processes, clear performance monitor values for all FBS-scheduled
processes scheduled on one or more CPUs, and specify whether or not time spent servic-
ing interrupts is to be included in performance monitor timing values.
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Figure 1-2.  Monitor Window

The Monitor window also allows you to specify whether performance monitoring
information is to be displayed in the Monitor window or written to a selected file. In either
case, you may specify the types of information that are to be reported, the resolution with
which performance monitor timing values are displayed (for example, microseconds, tens
of microseconds, milliseconds), and the rate at which values are to be updated.

The Monitor window allows you to specify a frequency-based scheduler with which the
window is to be associated.  It shows whether the scheduler is active or inactive, and it
shows whether the simulation is running or stopped. If the scheduler is active, it displays
the current major frame and current minor cycle for the simulation.  The Monitor window
also shows performance monitor values for selected processes.

Chapter 5, “Using the Monitor Window,” provides a detailed explanation of each area of
the Monitor window and provides reference information for all of the fields and controls
in each area.

Overview of RCIM Support 1

NightSim supports the Real-Time Clock and Interrupt Module (RCIM).  An RCIM is an
hardware module attached to a target system which contains the following interrupt-gener-
ating devices:

• real-time clocks (RTCs)

• edge triggered interrupts (ETIs)

• programmable interrupt generators (PIGs)

Any of these devices may be used as the timing source for an FBS.

RCIMs may be connected via RCIM cables such that interrupts from one RCIM may be
distributed to other systems in the RCIM chain.

Each interrupt device on an RCIM may be configured as an RCIM-distributed or normal
device.  By default, each interrupt device is available for use on the attached target system.
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If the interrupt device is configured as an RCIM-distributed device, interrupts are also dis-
tributed between target systems using the RCIM cable.

NightSim provides full support for the creation, control, and performance monitoring of
schedulers distributed across multiple SBC's and/or target computers in an RCIM chain
utilizing an RCIM-distributed device.

For more information see the Real-Time Clock and Interrupt Module (RCIM) PCI Form
Factor User’s Guide (0898007).
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Chapter 2Establishing the NightSim Environment

2
2
2

This chapter provides an overview of the primary factors that need to be taken into
account prior to running NightSim. These include system configuration requirements and
user requirements.

Configuration Requirements 2

NightSim requires the Frequency Based Scheduler to be installed on the target sytsem.
The FBS comes with the RedHawk distribution.                                                                               

Typically, the default installation of the FBS is sufficient for NightSim activities.  Refer to
the RedHawk Frequency-Based  Scheduler (FBS) User’s Guide (0898005) for more infor-
mation on FBS configuration.                                                                                

NightSim schedulers that are driven by an interrupt source require an RCIM device; a
real-time clock, an edge-triggered interrupt, or a distributed interrupt source.                                                                              

If you do not have an RCIM device, you can still use NightSim's end-of-process schedul-
ing capability to drive your simulation.  See End of Processing Cycle scheduling on page
4-2 for more information.

User Requirements 2

To use NightSim, you must also ensure that certain user requirements related to remote
shell access, environment variables, and capabilities are met. These requirements are
described in the sections that follow.

Remote Shell Access 2

NightSim uses the rsh(1) command on the NightSim host to execute programs on
remote systems, only if necessary.  When the Scheduler is in On-Line mode (see “On-
Line/Off-Line Operation” on page 4-6), if your timing host or any target system is not the
same as the NightSim host, the rsh(1) command will be used to start a NightSim server
process on each remote system.

The NightSim user must be able to use the rsh(1) command to access each remote sys-
tem involved and execute commands on those systems.
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Ensure that for each remote system, there exists a login with the same username as on the
NightSim host.  In addition, the .rhosts file in the home directory for that username on
each remote system must contain an entry for that username and the NightSim host.

If you use NightSim Scheduler only in Off-Line mode, it is not necessary to configure
systems for rsh(1) use.  

See the rsh(1) man page for more details.

Capabilities 2

RedHawk Linux provides a means to grant otherwise unprivileged users the authority to
perform certain privileged operations.  In this manner, processes are allowed to perform
sensitive system operations or override system restrictions.  The pam_capability(8)
(Pluggable Authentication Module) is used to manage sets of capabilities, called roles,
required for various activities.

Some of the operations associated with the frequency-based scheduler and the perfor-
mance monitor  require either root access or user registration in the fbscheduser capa-
bilities role.  Either execute the commands shown in the tutorial as the root user, or have
your system administrator register you as an FBS user according to the following instruc-
tions:

1. Add the following line to the /etc/pam.d/rsh and 
/etc/pam.d/login files:

session required pam_capability.so

NOTE

For those users that log into their system directly from the Gnome
or KDE graphical desktop environment, it is necessary to add the
above line to /etc/pam.d/gdm or /etc/pam.d/kde,
respectively.  In addition, you must restart your X server or reboot
your system before these changes will take effect.

For those user that log into their system using ssh, it is necessary
to add the above line to /etc/pam.d/sshd.  Additionally, edit
t h e  /etc/ssh/sshd_config  f i l e  a n d  e n s u r e  t h e
UsePrivilegeSeparation option is set to no.  Restart the sshd
service by executing the following command:

 service sshd restart

2. Add the following line to the bottom of the 
/etc/security/capability.conf file:
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user username fbscheduser

where username is the login name of the desired user.

3. Log off and log back onto the system for these changes to take effect.

4. You may verify your capabilities by issuing the following command:

/usr/sbin/getpcaps $$

which lists the current capabilities.

This list should include the following capability:

cap_sys_nice

which is necessary for the proper execution of this tutorial.

For additional information on capabilities, refer to the capability.conf(5) and
pam_capability(8) system manual pages.
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Chapter 3Getting Started

3
3
3

This chapter explains the procedures for beginning and ending a NightSim session. It also
explains how to get help and how to use accelerators.

Invoking NightSim 3

The NightSim tool is available on your system as /usr/bin/nsim. 

The format for executing nsim is as follows:

nsim [-help] [-version] [-offline] [-s hostname[,key]] 
           [-m hostname[,key]] [-Xoption ...] [[-f] file ...]

Options are described as follows:

-help This option allows you to display the usage information for Night-
Sim and then exit.

-version This option allows you to display the version and copyright
information for NightSim and then exit.

-offline Create Scheduler windows initially in Off-Line mode.  See
“On-Line/Off-Line Operation” on page 4-6 for more information.

-s hostname[,key]

This option allows you to create a Scheduler window.

The key parameter allows you to specify the key for a fre-
quency-based scheduler that is active on your system. Key specifies
an integer value that identifies the scheduler.  If the optional key
parameter is not specified, the new Scheduler window is inactive—
that is, it is not associated with a scheduler that exists on your sys-
tem.

The hostname parameter causes the window to be associated with an
FBS that is active on that particular system.  The hostname must
denote a host running the Concurrent Frequency Based Scheduler
and a NightSim server installed.  If the hostname parameter is not
specified, the system defaults to the local host (where NightSim is
running).

If an active scheduler associated with the specified key is found and
you have read permission for it, an active Scheduler window associ-
ated with the key is created. See Chapter 4, “Using the Scheduler
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Window,” for information about the Scheduler->Select Active
Scheduler menu item.

If a scheduler with the specified key does not exist, NightSim reports
an error.

This option may be used more than once; a Scheduler window will
be created for each occurrence of the option.

-m hostname[,key]

This option allows you to create a Monitor window.

The key parameter allows you to create a Monitor window that is
associated with a particular frequency-based scheduler. Key specifies
an integer value that identifies the scheduler with which you wish the
Monitor window to be associated.  If you do not specify the optional
key parameter and you have opened a Scheduler window, the new
Monitor window will display the same key as that displayed in the
Scheduler window.   

The hostname parameter causes the window to be associated with an
FBS with the specified key on that particular system.  The hostname
must denote a host running the Concurrent Frequency Based Sched-
uler and a NightSim server installed.  If the hostname parameter is
not specified, the system defaults to the local host (where NightSim
is running).

You must have read permission for the specified scheduler. You must
also have write permission for the scheduler if you wish to be able to
enable or disable performance monitoring for processes that are
scheduled on it.

This option may be used more than once; a Monitor window will be
created for each occurrence of the option.

-Xoption You may also specify any standard X Toolkit command-line option.
Such options include -bg color to set the color for the window back-
ground; -fg color to set the color to use for text or graphics; and
-xrm resourcestring to set selected resources. For a complete list of
these options, refer to the X(1) system manual page. 

[-f] file This option allows you to specify the name of a file that contains
configuration and scheduling data for a selected frequency-based
scheduler.  You may specify a full or relative pathname for the file.

To save the configuration and scheduling data entered in a particular
Scheduler window to a file, select the Schedu le r->Save
Con f i g F i l e As  menu item from that Scheduler window.
Procedures are fully explained in “Save Config File As...” on page
4-17.

You may also use a text editor to create or modify a configuration
file, following the format as described in “Configuration File
Format” on page B-1.
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When invoking NightSim, you may specify options in any order; you may specify the -f,
-s, and -m options one or more times as illustrated by the following example:

nsim -s buzzard,4 -s papio,5 -m papio,5 -f config_file

In this case, NightSim opens two active scheduler windows—one associated with the
scheduler identified by key 4 on target buzzard and one associated with the scheduler
identified by key 5 on target papio — a monitor window associated with the scheduler
identified by key 5 on target papio, and an inactive scheduler window associated with
the scheduler identified in config_file.

You may also invoke NightSim without specifying any options. Doing so allows you to
display an inactive Scheduler window. An inactive Scheduler window is one that is not
associated with a scheduler that exists on the system.

The steps for invoking NightSim are as follows:

5. Log in to your system.

6. Ensure that the value of your DISPLAY variable is set to the name of your
X server (or use the -display command-line option to the NightSim
command).

7. Type nsim and any desired options after the system command prompt, and
press the Enter key.

Getting Help 3

NightSim provides on-line help information through the Help menu which is accessible
via the menu bars in the Scheduler window (see “Introduction to the Scheduler Window”
on page 4-9) and Monitor window (see “Introduction to the Monitor Window” on page
5-6).  Figure 3-1 presents this menu:

Figure 3-1.  Help Menu

The following describe the options on the Help menu:
3-3



NightSim RT User’s Guide
On Context

Mnemonic:  C

Gives context-sensitive help on the various menu options, dialogs, or other parts of
the user interface.

Help for a particular item is obtained by first choosing this menu option, then click-
ing the mouse pointer on the object for which help is desired (the mouse pointer will
become a floating question mark when the On Context menu item is selected). 

In addition, context-sensitive help may be obtained for the currently highlighted
option by pressing the F1 key.  HyperHelpTM, NightProbe’s online help system, will
open with the appropriate topic displayed.

On Window

Mnemonic:  W

Displays help information for the current window.

On Help

Mnemonic:  H

Displays help information about how to use HyperHelpTM, NightSim’s online help
system.

NightSim User’s Guide

Mnemonic:  U

Opens the online version of the NightSim RT User’s Guide in the HyperHelp viewer.

NightStar RT Tutorial

Mnemonic:  S

Opens a HyperHelp window containing a tutorial which demonstrates the features
of NightSim, NightProbe, NightView, NightTrace, and NightTune in one cohesive
example.

Bookshelf

Mnemonic:  B

Opens a HyperHelp window that lists all of the currently available HyperHelp publi-
cations.

On Version

Mnemonic:  V
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Displays a short description of the current version of NightSim.

In addition, context-sensitive help may be obtained for the currently highlighted
option by pressing the F1 key. The HyperHelp viewer will open with the appro-
pri-ate topic displayed.

NightSim also provides help information through the Help buttons that appear in other
windows. When you click on the Help button in one of these windows, NightSim displays
the help information for that window.

Using Accelerators 3

A set of keyboard accelerators is defined for use within NightSim to provide quick access
to certain functions and menu items. Accelerators associated with menu items allow you
to access those items whether or not the menu is posted. Table 3-1 contains a list of the
accelerators and the resulting actions; where applicable, it indicates the menu items for
which the accelerators provide shortcuts. Note that you can define additional accelerators
through the use of X resources (refer to the X(1) system manual page. 

Table 3-1.  Accelerators

Accelerator Menu Item Action

<Control> <W> NightSim->Close Window Closes the current Scheduler or Monitor win-
dow

<Control> <Q> NightSim->Exit Exits NightSim

<Control> <N> Scheduler->New Clears all information from the current Sched-
uler window; resets the various areas to blank
or default values; and places the window in the
inactive state

<Control> <O> Scheduler->Open Config File In the current Scheduler window, opens a
scheduler configuration file that you have
previously saved 

<Control> <S> Scheduler->Save Config File Saves the configuration and scheduling data
entered in the current Scheduler window in the
file that is associated with the window

F1 Displays context help for the component that
currently has the focus
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Exiting NightSim 3

You may exit NightSim from the Scheduler or Monitor window by using one of the fol-
lowing techniques:

• Select the NightSim->Exit menu item.

• Press <Control> <Q>.

If you have not saved the changes that you have made in any window, you will be asked to
confirm that you wish to exit.
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4

This chapter describes the frequency-based scheduler and explains how scheduler
frequency is defined and how processes are scheduled. It introduces the components of
NightSim’s Scheduler window and describes the use of each component.

Understanding the Frequency-Based Scheduler 4

The frequency-based scheduler is a task synchronization mechanism that allows you to
run processes at frequencies that you specify. Frequencies can be based on high-resolution
clocks, an external interrupt source, or completion of a cycle. The frequency-based sched-
uler provides a mechanism for initiating processes at the specified frequency.

The frequency–based scheduler provides you with the ability to:

• Define FBS frequency in terms of the duration of a minor cycle and the
number of minor cycles per major frame

• Specify the scheduling parameters with which processes are scheduled

• Detect frame overruns for all FBS–scheduled processes

• View the status of FBS–scheduled processes

• Remove one or all FBS–scheduled processes from a scheduler

• Reschedule an FBS–scheduled process

• Start, stop, and resume scheduling on a frequency–based scheduler

• Connect a timing source to and disconnect it from a frequency–based
scheduler

• Control use of the real–time clock device as the timing source for a
frequency–based scheduler

• Configure up to 100 frequency–based schedulers system–wide in a single
processor or multiprocessor environment

• Use both frequency–based scheduling and static priority scheduling
simultaneously

In addition, NightSim provides the following additional capabilities for your convenience:

• Specify input and output files for scheduled processes

• Specify a working directory for scheduled processes.

• Schedule processes under xterm(1) terminal windows, providing the
option of interactive behavior
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• Schedule processes under the NightView debugger

NOTE

Some of these additional features are not available for schedulers
started via a saved script.

How Is Scheduler Frequency Defined? 4

You configure a frequency–based scheduler, in part, by defining the number of minor
cycles that compose a major frame. Minor cycles and major frames have associated with
them a duration of time that you can define by using a timing source for the scheduler. The
timing source can be the end of a minor cycle, a real–time clock, an edge–triggered inter-
rupt, or a user–supplied device. Procedures for using each of the devices as a timing
source are explained in detail in the RedHawk Linux Guide to Real-Time Services.

If you use end-of-cycle scheduling, scheduling is triggered when the last process that is
scheduled during the current minor cycle of the current major frame completes its process-
ing.

If you use a real–time clock as the timing source, you can specify the period in microsec-
onds or the frequency in hertz.

How Are Processes Scheduled? 4

You schedule processes to run at a certain frequency by specifying the first minor cycle in
which the process is to be wakened in each major frame (called the starting base cycle)
and the frequency with which it is to be wakened (called the period). 

If, for example, you schedule “Process 1” with a starting base cycle of zero and a period of
two, the process will be wakened once every two minor cycles, starting with the first
minor cycle in the frame. 

If you schedule “Process 2” with a starting base cycle of one and a period of four, that pro-
cess will be wakened once every four minor cycles, starting with the second minor cycle
in the frame. 

If you then schedule “Process 3” with a starting base cycle of two and a period of two, that
process will be wakened once every two minor cycles, starting with the third minor cycle
in the frame. 
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On a frequency–based scheduler configured with 100 minor cycles per major frame, these
processes will be wakened as illustrated in Table 4-1. 

The maximum frequency with which you can schedule a process is once per minor cycle
(a period of one); the minimum frequency is once per major frame (in the case of the
example, a period of 100).

A process runs until it calls an FBS library routine that causes it to sleep until the
frequency–based scheduler wakes it again. The frequency–based scheduler wakes those
sleeping processes that are scheduled to be wakened in the current minor cycle of the
current major frame and repeats the process for each minor cycle in the current frame. It
continues to repeat the entire process on every major frame until the scheduler is disabled.
A scheduler configured with 100 minor cycles per major frame, a minor cycle duration of
10,000 microseconds (0.01 second), and a major frame duration of one second wakes
processes as illustrated in Table 4-2. 

Table 4-1.  Process Scheduling

Minor Cycle Processes Wakened

0 Process 1

1 Process 2 

2 Process 1, Process 3 

3 

4 Process 1, Process 3 

5 Process 2 

... 

97 Process 2 

98 Process 1, Process 3

99 

Table 4-2.  Scheduler Operation

Major Frame Time Minor Cycle Processes Wakened

(sec.)

0 0 0 Process 1

 0.01 1 Process 2

 0.02 2 Process 1, Process 3

 ...

 0.97 97 Process 2

 0.98 98 Process 1, Process 3

 0.99 99
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As illustrated in Table 4-2: 

- When the current major frame is zero and the current minor cycle is zero,
the scheduler wakes “Process 1.”

- After 0.01 second, it wakes “Process 2”; after 0.02 second, it wakes “Pro-
cess 1” and “Process 3”; and so on.

- At one second, when the current major frame becomes one, the current
minor cycle becomes zero again, and the scheduler wakes “Process 1.”

- After .01 second, it wakes “Process 2.”

- After .02 second, it wakes “Process 1” and “Process 3”; and so on. 

- The scheduler continues repeating this process for as long as it is enabled.

It is important to note that a process may not always run at the frequency that you have
specified. A frame overrun occurs when a scheduled process does not finish its processing
before it is scheduled to run again. Overrun counts are maintained for each process and for
each scheduler. You can obtain information on overruns by querying a process in the Mon-
itor window (see Chapter 5, “Using the Monitor Window”). When you schedule a process

1 1.00 0 Process 1

 1.01 1 Process 2

 1.02 2 Process 1, Process 3

 ...

 1.97 97 Process 2 

 1.98 98 Process 1, Process 3

 1.99 99

 ...  

n n.00 0 Process 1

 n.01 1 Process 2

 n.02 2 Process 1, Process 3

 ..  

 n.97 97 Process 2

 n.98 98 Process 1, Process 3

 n.99 99

Table 4-2.  Scheduler Operation (Cont.)

Major Frame Time Minor Cycle Processes Wakened

(sec.)
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on a selected scheduler, you have the option of ensuring that the scheduler is stopped
when that process causes a frame overrun.

For additional information on the frequency-based scheduler, refer to the RedHawk Fre-
quency-Based  Scheduler (FBS) User’s Guide (0898005).   
4-5



NightSim RT User’s Guide
On-Line/Off-Line Operation 4

NightSim provides two modes of operation for a Scheduler, On-Line and Off-Line.  You
can toggle the current state by pressing the On-Line/Off-Line  button on either the
NightSim Scheduler window (see “On-Line/Off-Line” on page 4-22)  or the Edit Pro-
cess dialog associated with it (see “On-Line/Off-Line” on page 4-31).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit Pro-
cess dialog can be avoided.  When in Off-Line mode, the NightSim Scheduler will not
communicate with any servers on any timing host or target system of the Scheduler.

This is useful when creating a configuration for future use that deals with target systems
which may not currently exist or may not be currently accessible.  The values entered in a
Scheduler while it is Off-Line will be checked when the mode is changed to On-Line.

There are two ways to request a transition to On-Line mode:

1. Press the On-Line/Off-Line button on either the NightSim Scheduler or
its associated Edit Process dialog.  This toggles the value on the face of
the button.

2. Press the Set Up button on the Scheduler window.

In each of these cases, when going from Off-Line to On-Line, the information entered in
the Scheduler window and its associated Edit Process dialog is examined for correct-
ness given the current state of the timing host and target systems.  NightSim servers are
started if necessary, and all scheduled process attributes are checked for correctness.

If errors are found in the configuration, the user will be guided through the list of issues
discovered in the examination via the Verify Scheduler dialog.

Verify Scheduler 4

NightSim provides two modes of operation for a Scheduler, On-Line and Off-Line (see
“On-Line/Off-Line Operation” on page 4-6).  When going from Off-Line to On-Line,
the information entered in the Scheduler window and its associated Edit Process dialog
is examined for correctness given the current state of the timing host and target systems.

If errors are found in the configuration, the user will be guided through the list of issues
discovered in the examination via the Verify Scheduler dialog.  An example of such an
error is shown below.
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Figure 4-1.  Verify Scheduler Dialog

The operation of the buttons in the Verify Scheduler dialog is as follows:

Retry On-Line

If all problems found during the current verification process have been attended to,
the user may press this button to re-attempt  the transition to On-Line.

Previous Issue

Pressing this button will cycle to the previous issue found during the current verifi-
cation process.  The text describing the problem will be displayed in the Verify
Scheduler dialog.

Next Issue

Pressing this button will cycle to the next issue found during the current verification
process.  The text describing the problem will be displayed in the Verify Sched-
uler dialog.

Remain Off-Line

This button allows the user to continue to work off-line in lieu of the problems
found and attempt to transition to On-Line at a later time.

Help

This button displays appropriate information related to the problem currently dis-
played in the Verify Scheduler dialog.

For each issue, NightSim will highlight the label associated with the field most likely to be
of use in correcting the problem.  If that field is on a window that is not visible, NightSim
will raise the appropriate window to the top of the display.  Below is a portion of the
NightSim Scheduler window corresponding to the error listed in Figure 4-1.  Note that the
Timing host field is highlighted since the host name entered was invalid.
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Figure 4-2.  Errors found during transition to on-line

After making the appropriate changes, the user may retry the transition to On-Line mode
or may choose to remain in Off-Line mode.  If new problems are discovered when transi-
tioning to On-Line mode, the Verify Scheduler window will re-appear.
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Introduction to the Scheduler Window 4

The Scheduler window allows you to configure a frequency-based scheduler; select a tim-
ing source for it; schedule programs on it; start, stop, and resume a simulation; and view
scheduling data.

The Scheduler window consists of the following components:

• Menu Bar (see “Using the Scheduler Window Menu Bar” on page 4-11)

• On-Line/Off-Line Status Area (see “Using the On-Line/Off-Line Status
Area” on page 4-22) 

• Configuration File Name Area (see “Using the Configuration File Name
Area” on page 4-23) 

• Scheduler Configuration Area (see “Using the Scheduler Configuration
Area” on page 4-24) 

• Process Scheduling Area (see “Using the Process Scheduling Area” on
page 4-28) 

• Scheduler Control Area (see “Using the Scheduler Control Area” on page
4-43) 

• Simulation Control Area (see “Using the Simulation Control Area” on
page 4-47) 

• Run Status Area (see “Using the Run Status Area” on page 4-49) 

Figure 4-3 identifies the location of each of these components in the Scheduler window.
Note that this window contains sample data associated with a scheduler that exists on the
system.
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Figure 4-3.  Sample Scheduler Window 

Procedures for using each component of the Scheduler window are described in the
sections that follow.

Scheduler
Control

Area

Simulation
Control

Area

Run
Status
Area

Process
Scheduling

Area

Menu Bar

Scheduler
Configuration

Area

Configuration
File Name 

Area

On-Line/Off-Line
Status
Area
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Using the Scheduler Window Menu Bar 4

The Scheduler window menu bar is a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The Scheduler window menu bar provides access to the following menus:

• NightSim (see “NightSim” on page 4-12)

• Scheduler (see “Scheduler” on page 4-14)

• Tools (see “Tools” on page 4-20)

• Help (see “Help” on page 4-21)

Each menu is described in the sections that follow.
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NightSim 4

The NightSim menu appears on the Scheduler window menu bar (see “Using the Sched-
uler Window Menu Bar” on page 4-11).

The NightSim menu on the Scheduler window contains commands related to the global
operation of NightSim.  Figure 4-4 presents this menu.

Figure 4-4.  NightSim Menu

Descriptions of the options on the NightSim menu follow.

Create Scheduler Window

This option allows you to create a new Scheduler window. The new window is inac-
tive—that is, it is not associated with a scheduler that exists on your system. Its text
fields contain blanks or default values. You may create any number of Scheduler
windows.

Create Monitor Window

This option allows you to create a new Monitor window. If the Scheduler window
from which you create the window is associated with an existing scheduler, the key
and target for that scheduler will be displayed in the Status Area of the new Monitor
window.  In addition, if the scheduler is active, scheduled processes will be listed in
the Output Area of the new Monitor window.  Use of the Monitor window is fully
explained in Chapter 5, “Using the Monitor Window.”

Duplicate Window

This option allows you to create a new Scheduler window with the same configura-
tion as that of the Scheduler window from which this option was selected. 

Close Window

This option allows you to close the current Scheduler window. If the window is unti-
tled and contains unsaved changes, NightSim displays a warning dialog.  If you pro-
ceed with the current action without saving, these changes will be lost.  If you click
on the Yes button to save the changes, NightSim displays a file selection dialog.  If
you click on the No button, the changes will be discarded.  If you click on the Can-
cel button, the action is aborted.
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To select the file in which to save the changes, use the directory text area, file mask
area, list of directories, list of files, and file selection text area as appropriate. After
making a selection, you may save the changes to the selected file, search for another
file, cancel the operation, or display help related to the dialog.

If the Scheduler window is associated with a configuration file name and contains
unsaved changes, NightSim displays a warning dialog about saving changes.  If you
proceed with the current action without saving, these changes will be lost.  If you
click on the Yes button, the changes are saved in the file associated with the win-
dow.  If you click on the No button, the changes will be discarded.  If you click on
the Cancel button, the action is aborted.

If the window from which you select Close Window is the only window that you
have open, NightSim displays a confirmation dialog.  You may confirm that you
wish to exit, continue to keep the window open, or display help related to the dialog.

Exit

This option allows you to exit NightSim. If you have open Scheduler windows that
are untitled and contain unsaved changes or if you have an active scheduler, Night-
Sim displays a warning dialog.   In each case, you may save the changes, close the
window without saving the changes, cancel the close operation, or display help
related to the dialog. If you click on the Yes button to save the changes, NightSim
displays a file selection dialog.

If you have open a Scheduler window that is associated with a configuration file
name and contains unsaved changes, NightSim displays a warning dialog. If you
click on the Yes button, the changes are saved in the file associated with the win-
dow.

The warning dialogs are displayed for each window that contains unsaved changes.
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Scheduler 4

The Scheduler  menu appears on the Scheduler window menu bar (see “Using the
Scheduler Window Menu Bar” on page 4-11).

The Scheduler menu contains commands that affect the current Scheduler window.
Figure 4-5 presents this menu.

Figure 4-5.  Scheduler Menu

Descriptions of the options on the Scheduler menu follow.

New

This option allows you to clear all information from the current Scheduler window;
reset the various areas to blank or default values; and place the window in the inac-
tive state.  The timing host is preserved, however.

If the window is untitled and contains unsaved changes, NightSim displays a warn-
ing dialog.   You may save the changes, clear the window without saving the
changes, cancel the operation, or display help related to the dialog.   If you click on
the Yes button to save the changes, NightSim displays a file selection dialog.

If the window is associated with a configuration file name and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, clear the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button, the changes are saved in the file associ-
ated with the window.

NOTE

If the window containing the unsaved changes is associated with
an active scheduler, the scheduler will continue to run although
the window is no longer associated with it.
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Select Active Scheduler...

This option allows you to associate the current Scheduler window with a fre-
quency-based scheduler active on a given target system. When you select this
option, NightSim displays Figure 4-6.

If the window from which you select this option is untitled and contains unsaved
changes, NightSim displays a warning dialog.   You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog.   If you click on the Yes button to save the changes, NightSim displays a
file selection dialog.

If the window is associated with a configuration file name and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button, the changes are saved in the file associ-
ated with the window.

To assist you in selecting a scheduler, NightSim displays the selection dialog that
Figure 4-6 presents.

NOTE

NightSim needs to communicate with a target system in order to
determine which schedulers are active.  This will occur even if the
existing Scheduler window is Off-Line.  This is to be expected
since the existing scheduler will be abandoned when an active
scheduler is selected, and because an active scheduler is necessar-
ily On-Line (see “On-Line/Off-Line Operation” on page 4-6).

Figure 4-6.  Select Active Scheduler Dialog

This dialog provides a list of the active schedulers for the system designated by the
Target field.  The Target defaults to your local host and the list contains the active
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schedulers running on that particular system.  For instance, Figure 4-6 lists the two
schedulers currently running on the host amber2.

You may change the Target either by using the drop-down list or by typing the
name of the target system into the text field provided.  Entering an item in this field
will populate the list with the active schedulers on the specified target.

You may select a scheduler from the list that the dialog displays, or you may use the
Scheduler Key text field to enter the numeric key that is associated with the
desired scheduler. The key can be any positive integer value. Whether you select
from the list or enter a key, the selected scheduler must previously have been
configured, and you must have at least read permission for it; otherwise, NightSim
reports an error.

If you successfully select an existing scheduler, the Scheduler window becomes an
active window associated with that scheduler. Information related to the selected
scheduler replaces information that the window contained prior to the operation.

Open Config File...

This option allows you to open a scheduler configuration file that you have
previously saved. The file is opened in the current Scheduler window.

If the window from which you select this option is untitled and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button to save the changes, NightSim displays a
file selection dialog. 

If the window is associated with a configuration file name and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button, the changes are saved in the file associ-
ated with the window. 

To assist you in specifying a configuration file to be opened, NightSim displays a
file selection dialog.  After making a selection, you may open the selected file,
search for another file, cancel the operation, or display help related to the dialog.
When you open the selected file, the Scheduler window is associated with that file
and displays the configuration and scheduling data contained in the file.

NightSim will open the configuration file in Off-Line mode.  Once the file has been
read in, NightSim will make a transition to On-Line mode unless the -offline
option was used on the command line, or the *offline X resource was set to
True (see “X Resources” on page C-1).  When this transition occurs, the new
scheduler will be verified.  See “On-Line/Off-Line Operation” on page 4-6 for more
information.
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NOTE

NightSim 2.4 and earlier versions use a different format for this
configuration file.  NightSim 3.2 and later versions will automati-
cally convert these configuration files from the older format to the
newer format.  You will be prompted to save the converted config-
uration when you close the Scheduler window.

Save Config File

This option allows you to save the configuration and scheduling data entered in the
current Scheduler window in the file that is associated with the window.  If the con-
figuration file name has not yet been specified, this option is disabled; you should
use the Save Config File As... option.  See “Configuration File Format” on page
B-1 for a description of the format of this file as well as “Configuration File Exam-
ple” on page B-2 for the actual configuration file associated with Figure 4-3, “Sam-
ple Scheduler Window,” on page 4-10.

NOTE

NightSim 2.4 and earlier versions use a different format for this
configuration file.  NightSim 3.2 and later versions will automati-
cally convert these configuration files from the older format to the
newer format.  You will be prompted to save the converted config-
uration when you close the Scheduler window.

Save Config File As...

This option allows you to specify the name of the file in which you wish the
configuration and scheduling data entered in the current Scheduler window to be
saved. 

When you select this option, NightSim displays a file selection dialog. After making
a selection, you may save the current configuration and scheduling data in the
selected file, search for another file, cancel the operation, or display help related to
the dialog.

See “Configuration File Format” on page B-1 for a description of the format of this
file as well as “Configuration File Example” on page B-2 for the actual configura-
tion file associated with Figure 4-3, “Sample Scheduler Window,” on page 4-10.

NOTE

NightSim 2.4 and earlier versions use a different format for this
configuration file.  NightSim 3.2 and later versions will automati-
cally convert these configuration files from the older format to the
newer format.  You will be prompted to save the converted config-
uration when you close the Scheduler window.
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Save Script...

This option allows you to save the current configuration as a shell script containing
rtcp commands.  The script may be run from any host in your network as long as it
has rsh(1) access to all the targets, as well as the timing host (see “Remote Shell
Access” on page 2-1).  This script can then be used to recreate your scheduler con-
figuration without the added overhead of NightSim, allowing your application to
start up and run more quickly.  This can be extremely useful when dealing with
time-critical applications.

The main disadvantage of using this script instead of using NightSim is that you do
not get any monitoring capabilities.  This may be less important for systems that are
typically used in production environments but can be critical to those systems used
in a testing/development environment where the monitoring feedback that NightSim
provides can be invaluable.

Another disadvantage is that the script does not support starting your processes
under NightView or xterm(1).  For this features, you must use the NightSim
scheduler to start your scheduler.

If a scheduler which makes use of xterm or NightView is saved as a script, Night-
Sim will ignore these points and schedule the processes directly.  If File input or
output is used, NightSim will honor those filenames, but if the scheduler uses Stan-
dard Input Stream or Standard Output Stream, NightSim will forcibly redi-
rect from or to /dev/null in order to prevent rsh from hanging while waiting for
input or output.

Note that this script is different from the rtcp-style configuration files found in
NightSim 2.4 and earlier versions.  See “Configuration File Format” on page B-1 for
details on this new format.

Set Clock Resolution...

This option allows you to select the resolution for a real-time clock that you have
selected as the timing source for a scheduler. The resolution indicates the duration in
microseconds of one clock count. 

The duration of a minor cycle is defined by specifying the number of clock counts
per minor cycle (1 to 65,535) and the number of microseconds per clock count (1,
10, 100, 1000, or 10,000). You determine the duration of a major frame by multiply-
ing the duration of a minor cycle by the number of minor cycles per major frame. If,
for example, you configure a scheduler with 100 minor cycles per major frame and
you use as the timing source a real–time clock with a clock count of 10,000 and a
clock count duration of one microsecond, each minor cycle has a duration of 10,000
microseconds, or 0.01 second, and each frame a duration of one second.

When you select this option, NightSim displays the selection dialog that Figure 4-7
presents.
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Figure 4-7.  Set Clock Resolution Dialog

You select the resolution by clicking on the toggle button and choosing one of the
following options: 1, 10, 100, 1000, or 10000. You may apply your selection,
cancel the operation, or display help related to the dialog.

The resolution of the clock affects the valid range of the clock period.  See “Clock
period” on page 4-27.

Detailed Scheduler Info...

(Expert mode only)

The dialog associated with this option provides more information about the current
FBS which may be of interest to some users.

This option appears on the Scheduler menu (see “Scheduler” on page 4-14) only
when the user is running in expert mode.  See the expert resource under “X
Resources” on page C-1 for more details.
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Tools 4

The Tools menu appears on the Scheduler window menu bar (see “Using the Scheduler
Window Menu Bar” on page 4-11) as well as on the Monitor window menu bar (see
“Using the Monitor Window Menu Bar” on page 5-7).

The Tools menu contains a list of other NightStar tools that can be launched directly from
NightSim.

Figure 4-8.  Tools Menu

Descriptions of the options on the Tools menu follow.

NightBench Builder

Opens the NightBench Program Development Environment.

NightBench is a set of graphical user interface (GUI) tools for developing software
with the Concurrent  MAXAdaTM compiler.

See the NightBench User’s Guide (0890480) for more information.

NightProbe Monitor

Opens the NightProbe Data Monitoring application.

NightProbe is a real-time graphical tool for monitoring, recording, and altering pro-
gram data within one or more executing programs without significant intrusion.
NightProbe can be used in a development environment as a tool for debugging, or in
a production environment to create a “control panel” for program input and output.

See the NightProbe RT User’s Guide (0898480) for more information.

NightTrace Analyzer

Opens the NightTrace Analyzer.  

The NightTrace Analyzer is a graphical tool for analyzing the dynamic behavior of
multiprocess and/or multiprocessor user applications and operating system activity.
NightTrace allows you to control user and kernel trace collection daemons and can
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graphically display the interplay between many real-time programs and processes
across multiple processors and systems.

See the NightTrace RT User’s Guide (0898398) for more information.

NightTune Tuner

Opens the NightTune Performance Tuner.

NightTune is a graphical tool for analyzing the status of the system in terms of pro-
cesses, interrupts, context switches, interrupt CPU affinity, processor shielding and
hyperthreading control as well as network and disk activity.  NightTune can adjust
the scheduling attributes of individual or groups of processes, including priority,
policy, and CPU affinity.

See the NightTune RT User’s Guide (0898515) for more information.

NightView Debugger

Opens the NightView Source-Level Debugger.

NightView is a graphical source-level debugging and monitoring tool specifically
designed for real-time applications.  NightView can monitor, debug, and patch mul-
tiple real-time processes running on multiple processors with minimal intrusion.

See the NightView RT User’s Guide (0898395) for more information.

Help 4

The Help menu appears on the Scheduler window menu bar (see “Using the Scheduler
Window Menu Bar” on page 4-11) as well as on the Monitor window menu bar (see
“Using the Monitor Window Menu Bar” on page 5-7).

The Help menu provides access to the on-line help system.  See “Getting Help” on page
3-3 for detailed information about this menu and each of its items.
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Using the On-Line/Off-Line Status Area 4

The On-Line/Off-Line Status Area is a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The On-Line/Off-Line Status Area shows the name of the NightSim host as well as an
On-Line/Off-Line toggle button indicating the current state of operation of the Sched-
uler (see “On-Line/Off-Line Operation” on page 4-6). 

Figure 4-9.  Scheduler Window - On-Line/Off-Line Status Area

On-Line/Off-Line

NightSim provides two modes of operation for a Scheduler, On-Line  and
Off-Line (see “On-Line/Off-Line Operation” on page 4-6).  You can toggle the cur-
rent state by pressing the On-Line/Off-Line button on either the NightSim Sched-
uler window or its associated Edit Process dialog (see “Edit Process” on page
4-30).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit
Process dialog can be avoided.  When in Off-Line mode, the NightSim Scheduler
will not communicate with any servers on any timing host or target system of the
Scheduler.

This is useful when creating a configuration for future use that deals with target sys-
tems which may not currently exist or may not be currently accessible.  The values
entered while Off-Line will be checked when the mode is changed to On-Line.
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Using the Configuration File Name Area 4

The Configuration File Name Area is a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The Configuration File Name Area shows the name of the configuration file with which
the current Scheduler window is associated. 

Figure 4-10.  Scheduler Window - Configuration File Name Area

If the window contains unsaved changes, the name is followed by a warning icon as illus-
trated by Figure 4-10. When the Scheduler window is not associated with a configuration
file name, the Configuration File Name Area displays (unnamed)  as illustrated by
Figure 1-1 (see p. 1-3). 
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Using the Scheduler Configuration Area 4

The Scheduler Configuration Area is a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The Scheduler Configuration Area allows you to configure a frequency-based scheduler,
select the timing source that is to be used for it, and specify the permissions that are to be
associated with it.

Figure 4-11.  Scheduler Window - Configuration Area

Descriptions of the text fields and controls contained in the Configuration Area follow:

Scheduler key

This field allows you to specify a key for the frequency–based scheduler that you
wish to create. The key is a user–chosen numeric identifier with which the scheduler
will be associated. It can be any positive integer value. Note that the number of
schedulers that can be configured at one time cannot exceed the value of FBSMNI,
which is the maximum number of frequency–based schedulers permitted on your
system (see Chapter 2, “Establishing the NightSim Environment,” for a description
of system tunable parameters).

Cycles per frame

This field allows you to specify the number of cycles that compose a frame on the
specified scheduler.

Max. tasks per cycle

This field allows you to specify the maximum number of processes that can be
scheduled to execute during one cycle. 

Max. tasks in scheduler

This field allows you to specify the maximum number of processes that can be
scheduled on the specified scheduler at one time. The number must be less than or
equal to the product that is obtained by multiplying the values specified in the
Cycles per frame and the Max. tasks per cycle text fields. Enter a number
ranging from one to the product of these values. 
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Permissions

This field allows you to specify the permissions required for operations related to
the specified scheduler. Enter three octal digits––the first indicating permissions
granted to the owner, the second indicating those granted to the group, and the third
indicating those granted to other users. The octal method for setting permissions
associated with a scheduler is the same as that used for specifying mode with the
chmod command (for assistance in using this method, see the system manual page
for chmod(1)). The default, 600, grants read and alter (write) permission to the
owner only.

Timing host

This field allows you to select the host of the timing source for the scheduler.  You
may enter the name of the host directly in the entry field or choose from the supplied
list.  

This list contains a list of possible timing hosts.  NightSim maintains a list in
~/.NightSimHosts of all hosts you ever used as a timing host.  Once selected,
the Timing source menu is repopulated with the set of devices available on that
host.

This field is empty by default.  The user must provide a Timing host name.

NOTE

The timing host cannot be changed while the scheduler is active;
you must first remove the scheduler.

Timing source

This option menu allows you to select the timing source for the scheduler.  The
timing source can be the end of a minor cycle, a real-time clock, an edge-triggered
interrupt, or a user-supplied device.  Figure 4-12 presents an example of the option
menu. 
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Figure 4-12.  Timing Source Option Menu

This list contains the set of devices available on the timing host.  Note that the
options that NightSim displays vary according to the devices that are configured in
the system designated as the timing host and may change if the timing host is
changed.  This list will be initially populated with the devices on the defaut timing
host.

If you select the End of processing cycle option from the Timing source
option menu, scheduling is triggered when the last process that is scheduled during
the current minor cycle of the current major frame completes its processing.

If you select a real-time clock, the Clock period text field is enabled so that you
can specify the information needed to set the clock. 

If you select the Other. . .option, NightSim displays the dialog shown in
Figure 4-13. The text input area in this dialog allows you to specify the name of a
user-supplied device that you wish to use as the timing source. The Device Path-
name must be the name of a device file on the currently selected timing host and
that is supported by the RedHawk kernel as a FBS timing device.   Currently, the
only devices supported are those associated with an RCIM.

NOTE

The user is responsible for ensuring that the Timing source is
appropriate for the selected Distribution.  If it is determined to
be inappropriate at the time that the scheduler is Set up, an error
message will be issued by NightSim.
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Figure 4-13.  Other Device Prompt Dialog

Clock period

If you select a real-time clock as the timing source for the scheduler, this field
allows you to specify a value to be used in setting the clock.  Otherwise, this field is
disabled. 

You may specify the period in microseconds, milliseconds, hertz, or kilohertz by
clicking on the toggle button and choosing the desired option. Below the field is a
label that shows the minimum and maximum values that are permitted. The label
changes according to the option you choose. Figure 4-14 presents the options from
which you may choose.

Figure 4-14.  Clock Period Options 

The valid range of the clock period is determined by multiplying the minimum and
maximum clock counts, 1 and 65535, by the clock resolution, which defaults to 10
microsends.  By chainging the clock resolution, you can increase or decrease the
valid range of the clock period.  See “Set Clock Resolution...” on page 4-18 to adjust
the number of microseconds per clock count.
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Using the Process Scheduling Area 4

The Process Scheduling Area is a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-9).

The Process Scheduling Area allows you to: 

- add programs to a frequency-based scheduler

- remove FBS-scheduled processes from a scheduler

- reschedule FBS-scheduled processes

- view scheduling data for current FBS-scheduled processes

- select the processes for which scheduling data are to be displayed.

Figure 4-15.  Scheduler Window - Process Scheduling Area

The Process Scheduling Area contains a scrolling list of the processes that are currently
scheduled on a frequency-based scheduler and the parameters with which they have been
scheduled (CPU mask, scheduling policy and priority, starting minor cycle, and so on).
You can select the process or processes that you wish to reschedule or delete by clicking
on the respective item(s) in this list.

In addition, the Process Scheduling Area includes a grid that graphically shows the
execution cycle for each process in the list. The labels at the top of the grid show the num-
ber of the minor cycle. The minor cycles in which each process is scheduled to run are
denoted by the appearance of the letter X in the appropriate column. You can use the hori-
zontal and vertical scroll bars to scroll the visible contents of the grid.

The Process Scheduling Area contains a row of process controls below the list of
FBS-scheduled processes.  These controls are explained below:

Edit...

This push button allows you to add a program to a frequency-based scheduler or
reschedule an FBS-scheduled process. When you click on this button, NightSim dis-
plays the Edit Process dialog (see “Edit Process” on page 4-30). Note that if you
select a process from the list of scheduled processes and then click on this button,
the dialog contains the scheduling parameters for the selected process. NightSim
also displays the Edit Process dialog if you double click on a line in the list of
scheduled processes.
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Delete

This button allows you to delete FBS-scheduled processes from a scheduler.  All
processes that are selected in the list will be deleted.  When you click on this button,
NightSim displays the Delete Processes dialog (see “Delete Processes” on page
4-41).

Filter...

This button allows you to specify the FBS-scheduled processes that you wish to be
displayed in the Process Scheduling Area of the Scheduler window (see “Using the
Process Scheduling Area” on page 4-28).  When you click on this button, NightSim
displays the Filter Process List dialog (see “Filter Process List” on page 4-42).

Refresh 

This button is enabled only when the Scheduler window is active.  Clicking on this
button updates the scheduler and process information in the window.  If a process
terminates, for example, it will remain in the process list until the Refresh button is
clicked, at which time it will be removed.
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Edit Process 4

The Edit Process dialog allows you to add a program to a frequency-based scheduler or
reschedule an FBS-scheduled process.  Note that if you had selected a process from the list
of scheduled processes in the Process Scheduling Area (see “Using the Process Schedul-
ing Area” on page 4-28) and then clicked on the Edit button, this dialog will contain the
scheduling parameters for the selected process. NightSim also displays the Edit Process
dialog if you double click on a line in the list of scheduled processes.

The Edit Process dialog is shown in Figure 4-16:

Figure 4-16.  Edit Process Dialog

The following fields appear at the top of the Edit Process dialog:

PID

This field specifies the unique frequency-based scheduler process identifier that is
obtained when a program is scheduled on a scheduler. When a program has not yet
been scheduled on the scheduler, this field displays “(Scheduler is inactive)”.

Target System

This item indicates the target system on which this process is to be scheduled.
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On-Line/Off-Line

NightSim provides two modes of operation for a Scheduler, On-Line  and
Off-Line (see “On-Line/Off-Line Operation” on page 4-6).  You can toggle the cur-
rent state by pressing the On-Line/Off-Line button on either the the NightSim
Scheduler window or the Edit Process dialog associated with it  (see “Using the
On-Line/Off-Line Status Area” on page 4-22).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit
Process dialog can be avoided.  When in Off-Line mode, the NightSim Scheduler
will not communicate with any servers on any timing host or target system of  the
Scheduler.

This is useful when creating a configuration for future use that deals with target sys-
tems which may not currently exist or may not be currently accessible.  The values
entered while Off-Line will be checked when the mode is changed to On-Line.

Working Directory

You may specify the path to the working directory in which the scheduled process
will run.  This path must be a valid directory name on the target system.  If the target
system is not available, or if the Scheduler is Off-Line (see “On-Line/Off-Line
Operation” on page 4-6), the path must be a valid directory on the target system at
the time the program scheduler is created (i.e. when the Set up button is pressed on
the Scheduler window).

Select...

You may use the Select button to bring up the Select a Directory dialog
to specify the working directory for the program you want to configure under
the FBS.

Process Name

This field specifies the name of the process that you wish to schedule.  Enter a full
or relative pathname (see “Pathname Expansion” on page 4-40).  The pathname
must be valid on the target system to which this process is assigned.  If you have
selected a process from the list of FBS-scheduled processes prior to clicking on the
Edit button, this field contains the name of the FBS-scheduled process.

NOTE

You cannot change the name of a process while the process is run-
ning.  You must either stop the scheduler first or add a new pro-
cess with the desired name.

Select...

You may use the Select button to bring up the Select a Program dialog to
choose the program you want to configure under the FBS.  Note that NightSim
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displays files on the selected target system if it is reachable via the network.  If
the target system is unavailable, NightSim will disable file browsing on the
target system.  In addition, the Scheduler must be operating in an On-Line
state in order to browse on the target file system (see “On-Line/Off-Line
Operation” on page 4-6).

The bottom portion of the Edit Process dialog is divided into a number of pages that
contain various parameters related to the given process.  These pages are:

- FBS (see “FBS” on page 4-33)

- Process (see “Process” on page 4-36)

- I/O and Debug (see “I/O and Debug” on page 4-38)

NOTE

If the Process Name is /idle, then all of the fields which are
inappropriate for the / idle  pseudo-processes are desensitized.
Only the CPU Bias field is valid for /idle.

After you have entered the scheduling parameters for a specified program, you may apply
the changes and close the Edit Process dialog, apply the changes without closing the
dialog, add another program to the scheduler, reset the contents of the dialog to its initial
state, cancel the changes and close the dialog, or display help for the dialog.
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FBS 4

The FBS tab of the Edit Process dialog (see “Edit Process” on page 4-30) allows the
user to specify parameters such as the starting cycle, period, and overrun limits for the
given process.

The FBS page of the Edit Process dialog is shown in Figure 4-17:

Figure 4-17.  Edit Process Dialog - FBS 

Parameter

This field allows you to pass an integer value to a process that is scheduled on a
frequency–based scheduler. The value must be a 32-bit decimal value. The default is
no value. The process can retrieve this value by using the sched_fbsqry(3)
library routine.

Soft Ovrn. Limit

This field allows you to specify a consecutive overrun limit count that this process
will tolerate and have processed as soft overruns by the kernel.  Soft overruns are
catastrophic failures only if the process reaches its limit on the number of soft over-
runs tolerated.  This soft overrun limit defaults to 0 for each process.
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Overrun

This check button allows you to indicate whether or not the selected scheduler
should be stopped in the event that the specified program causes a frame overrun.
Turn this button on if you wish the scheduler to be stopped. 

NOTE

This may useful in conjunction with scheduling a process under
the NightView debugger, making it easier to stop a scheduled pro-
cess at the source of an overrun and determine the activity which
caused the overrun to occur.

Starting cycle

This field allows you to specify the first minor cycle in which the specified program
is to be wakened in each major frame. Enter a number ranging from zero to the total
number of minor cycles per frame minus one. (The total number of minor cycles per
frame is defined when you use the Scheduler Configuration Area to configure a
scheduler.  See “Using the Scheduler Configuration Area” on page 4-24 for details.)

NightSim displays the range of starting cycle values that you can enter next to the
Starting cycle field.

NOTE

You must enter a starting cycle of zero for unscheduled processes
(for an explanation of unscheduled processes, see Chapter 5,
“Using the Monitor Window,” and the section entitled “Monitor-
ing Unscheduled Processes”).

Period

This field allows you to establish the frequency with which the specified program is
to be wakened in each major frame. A period of one indicates that the specified
program is to be wakened every minor cycle; a period of two indicates that it is to be
wakened once every two minor cycles, a period of three once every three minor
cycles, and so on. Enter the number of minor cycles representing the frequency with
which you wish the program to be wakened. This number can range from zero to the
number of minor cycles that compose a frame on the scheduler. (The total number of
minor cycles per frame is defined when you use the Scheduler Configuration Area
to configure a scheduler.  See “Using the Scheduler Configuration Area” on page
4-24 for details.) 

NightSim displays the range of period values that you can enter next to the Period
field.
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NOTE

You must enter a period of zero for unscheduled processes (for an
explanation of unscheduled processes, see Chapter 5, “Using the
Monitor Window,” and the section entitled “Monitoring Unsched-
uled Processes”).   

NOTE

If the Period of a process is changed while the scheduler is run-
ning, the Monitor window will not reflect the updated value until
the next Monitor window update after the process runs again.
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Process 4

The Process tab of the Edit Process dialog (see “Edit Process” on page 4-30) allows
the user to specify the CPU bias, scheduling policy, and priority of the given process.

The Process page of the Edit Process dialog is shown in Figure 4-18:

Figure 4-18.  Edit Process Dialog - Process 

CPU Bias

This panel of check buttons allows you to select the processor or processors on
which the program can be scheduled. Click on one or more buttons, where the label
0 represents the first logical CPU, 1 represents the second, and so on. To select all
CPUs on your system, click on the All CPUs button.

NOTE

If the CPU Bias of a process is changed while the scheduler is
running, the Monitor window will not reflect the updated value
until the next Monitor window update after the process runs again.
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NOTE

You cannot change the CPU bias of /idle while the scheduler is
active because it is not a real process.  You must either add a new
process with the desired CPU bias, or make the change while the
scheduler is inactive.  See “How Is Idle Time Monitored?” on
page 5-3 for more information.

Sched Policy

This panel of radio buttons allows you to select the POSIX scheduling policy for the
specified program. The options are as follows: the FIFO  (first–in–first–out)
scheduling policy, the Round Robin scheduling policy, and the Other (interac-
tive) scheduling policy. 

For a full description of the behavior of processes that are scheduled under the
respective policies, refer to the “Process Scheduling and Management” chapter of
the RedHawk Linux Programming Guide.

Priority

The range of priority values that you can enter is governed by the scheduling policy
specified. You can determine the allowable range of priorities associated with each
policy (FIFO, Round-Robin, or Other) by invoking the run(1) command from the
shell and not specifying any options or arguments (see the corresponding system
manual page for an explanation of this command). Higher numerical values
correspond to more favorable scheduling priorities.

NightSim displays the range of priority values that you can enter next to the
Prior ity field.

For complete information on scheduling policies and priorities, refer to the “Process
Scheduling and Management” chapter of the RedHawk Linux Programming Guide.

NOTE

If the Priority of a process is changed while the scheduler is run-
ning, the Monitor window will not reflect the updated value until
the next Monitor window update after the process runs again.
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I/O and Debug 4

The I/O and Debug tab of the Edit Process dialog (see “Edit Process” on page 4-30)
allows the user to specify where to read input from, where to send output, and if the pro-
cess is to be scheduled within a NightView dialogue or within an xterm(1) window.

The I/O and Debug page of the Edit Process dialog is shown in Figure 4-19:

Figure 4-19.  Edit Process Dialog - I/O and Debug 

Debug

Schedule this process under the NightView debugger.  When the Schedule pro-
gram within a NightView dialogue checkbox is checked, the process will be
stopped at the point it begins execution, allowing early intervention for the purpose
of setting breakpoints, watchpoints, etc.  A resume command to NightView is
required to resume the execution of the scheduled process.

NOTE

Scheduling processes under the FBS requires certain capabilites
(see “Capabilities” on page 2-2).  It is the responsibiliy of the user
to ensure that appropriate capabili are granted to the NightView
session.
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X Terminal

Schedule the process in an xterm(1) window.  An xterm window may be used in
conjunction with scheduling the process under NightView as well, if so desired (see
Debug above).  This permits the scheduled process to interact with the terminal
services provided by the xterm.

Read Input From

Select the input source, if any, for the scheduled process.  By default, as in previous
versions of NightSim, input is taken from the file, /dev/null.  When either the
Debug or X Terminal checkboxes are selected, the default is to permit input to
come from the Standard Input Stream, but you may choose File input in either
case if your scheduled program needs a fixed input stream (see Input File below).

Input File

If File is selected for Read Input From, this field specifies the name of the input
file which the scheduled process will use.  By default, the file is /dev/null.  See
“Pathname Expansion” on page 4-40.

If the NightSim Scheduler is On-Line (see “On-Line/Off-Line Operation” on page
4-6), the pathname given must be a valid file on the target system with sufficient
read permissions.

If the NightSim Scheduler is Off-Line, the path must represent a valid readable file
at the time the program scheduler is created (i.e. when the NightSim Scheduler tran-
sitions to an On-Line mode of operation).

Select...

You may use the Select button to bring up the Select a File dialog to spec-
ify the name of the input file which the scheduled process will use.

Send Output To

Select the way to manage output from your scheduled process.  If neither the
Debug  and X Terminal checkboxes are selected, you may select File output,
where the default file is /dev/null.  Output may be sent to an actual file specified
in the Output File field, if desired.  By default, output is sent to the Standard
Output Stream of the scheduled process.

Output File

If File is selected for Send Output To, this field specifies the name of the output
file to generate.  The output file name may be a full pathname or may be a pathname
relative to the Working Directory specified for the scheduled process.  See “Path-
name Expansion” on page 4-40.
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Select...

You may use the Select button to bring up the Select a File dialog to spec-
ify the name of the output file that will be generated.

Pathname Expansion 4

When entering the Process Name, Input File, or Output File in the Edit Process
dialog (see “Edit Process” on page 4-30), the user can make use of the following
conventions:

- if the pathname begins with /, it is assumed to be fully rooted

- if the pathname begins with ., .., or a simple file or directory name, it is
assumed to be relative to the path in the Working Directory field

- if the pathname begins with ~, it is interpreted according to the values of
the following environment variables on the NightSim host:

- ~, ~/, or ~user (where user is the username of the user running
NightSim), the login directory of the user is substituted

- ~otheruser (where othername is a user other than the user running
NightSim), the login directory of otheruser is substituted

- ~+, the value of $PWD on the NightSim host is substituted.

- ~-, the value if $OLDPWD on the NightSim host is substituted

- if any part of the pathname contains an environment variable reference of
the form $name, the value of $name on the NightSim host is substituted

The pathnames will be expanded and substitutions made at the time the Apply or Add
button is pressed.
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Delete Processes 4

The Delete Processes dialog is presented when deleting FBS-scheduled processes after
pressing the Delete  button in the Process Scheduling Area (see “Using the Process
Scheduling Area” on page 4-28).

If the scheduler is active when you click on this button, NightSim displays a dialog to con-
firm killing the selected processes.  You may press the Yes button to kill the selected pro-
cesses after deleting them from the frequency-based scheduler.  You may also press the
No button to delete the processes from the scheduler but allow them to continue executing
or press Cancel to abort the action.

If the scheduler is inactive when you click on this button, NightSim displays a dialog to
confirm deleting the processes.  You may press OK to delete the processes from the sched-
uler or Cancel to cancel the operation.
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Filter Process List 4

The Filter Process List dialog allows you to specify the FBS-scheduled processes that
you wish to be displayed in the the Process Scheduling Area (see “Using the Process
Scheduling Area” on page 4-28) of the Scheduler window.  When you click on this button,
NightSim displays the dialog that Figure 4-20 presents.

Figure 4-20.  Filter Process List Dialog  

Filter Process List

This list contains all of the processes that are scheduled on the scheduler and indi-
cates whether or not they are visible in the list presented in the Process Scheduling
Area of the Scheduler window (see “Using the Process Scheduling Area” on page
4-28 for details). You may use the mouse to select the process or processes that you
wish to show or hide and then click on the Show or Hide button as desired.

You may also use a combination of the following items to specify which processes you
wish to show or hide:

FPID

You may specify the unique frequency-based scheduler process identifier for a pro-
cess that you wish to show or hide.

Program Name

You may specify the name of the process that you wish to show or hide.  Enter a full
or relative pathname.  The pathname must be valid on the target system to which this
process is assigned.

CPU Mask

This panel of check buttons allows you to show or hide processes which are sched-
uled on the specified processor or processors. Click on one or more buttons, where
the label 0 represents the first logical CPU, 1 represents the second, and so on.  To
select all CPUs on your system, click on the All button.
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If an FBS-scheduled process with the specified identifier(s) does not exist, NightSim
reports an error. If more than one FBS-scheduled process with the specified identifier(s)
exists, all such processes are shown or hidden.

Show

Lists in the Process Scheduling Area (see “Using the Process Scheduling Area” on
page 4-28) of the Scheduler window those processes either selected in the Filter
Process List or specified using FPID, Program Name, or CPU Mask .

Hide

Removes from the Process Scheduling Area (see “Using the Process Scheduling
Area” on page 4-28) of the Scheduler window those processes either selected in the
Filter Process List or specified using FPID, Program Name, or CPU Mask.

Using the Scheduler Control Area 4

The Scheduler Control Area is a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-9).

The Scheduler Control Area allows you to create and remove a frequency-based sched-
uler. It contains two push buttons that you use to perform these functions: the Set up but-
ton and the Remove button.  

Figure 4-21.  Scheduler Window - Scheduler Control Area
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The Scheduler Control Area also contains an icon that indicates the current state of the
Scheduler window. 

Figure 4-3 illustrates a Scheduler window that is in the active state.

The Set up button is enabled only when the window is in the inactive state. When you
click on the Set up button, NightSim carries out the following actions:

• Transitions the NightSim Scheduler to an On-Line mode of operation, if
the NightSim Scheduler is operating in an Off -L ine  mode (see
“On-Line/Off-Line Operation” on page 4-6).  The state of the target on
which processes are scheduled, the existence and execute permissions of
each scheduled program, and the existence and read permissions for any
input files required.

• Determines whether there is an existing scheduler that is associated with
the same key as that entered in the current window.

If an active scheduler with the same scheduler key as the key you selected
already exists on the target systemto which you assigned processes, Night-
Sim displays the dialog that Figure 4-22 presents.

Figure 4-22.  Scheduler Exists Dialog

When the window is inactive, NightSim shows an
unplugged connection.

When the window is active, it shows a plugged
connection.
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You have two main choices:

- Work with the existing FBS, in which case the active FBS’s configu-
ration will appear in the Scheduler window in place of the current
configuration.

or

- Replace the existing FBS with a new scheduler based on the configu-
ration in the window.

If you decide to replace the existing FBS, you then need to decide what to do
with the processes running under the old FBS.

You may also press the Cancel button to abort this action.

• Creates a scheduler that is configured according to the parameters specified
in the Scheduler Configuration Area of the window (see “Using the Sched-
uler Configuration Area” on page 4-24 for details)

• Schedules the processes that are listed in the Process Scheduling Area of
the window and starts them running (see “Using the Process Scheduling
Area” on page 4-28 for details). Programs will run up to the first fbswait
system call.

• Attaches the timing source to the scheduler

• Enables the Start button in the Simulation Control Area 

Initially, the simulation is stopped. For an explanation of the Simulation
Control Area, see “Using the Simulation Control Area” on page 4-47. 

• Disables the Set up button and enables the Remove button

• Places the window in the active state and changes the state icon and title
bar accordingly 

The Remove button is enabled only when the window is in the active state. When you
click on the Remove button, NightSim carries out the following actions:

• Displays a dialog verifying that NightSim should kill the processes running
on the scheduler.  You may press Yes to kill the processes that are cur-
rently scheduled on the scheduler, No to remove the processes from the
scheduler but allow them to continue executing, or Cancel to abort the
action.

• Stops the simulation if it is running

• If a real-time clock is being used as the timing source, and the scheduler is
running, stops the clock.

• Detaches the timing source from the scheduler or disables end-of-cycle
scheduling

• Removes all processes that are currently scheduled on the scheduler from it
and either terminates them or allows them to continue executing in
accordance with the selections made in response to the dialog presented.
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• Removes the scheduler from the system

• Disables the Start, Stop, and Resume buttons in the Simulation Control
Area 

For an explanation of the Simulation Control Area, see “Using the Simula-
tion Control Area” on page 4-47

• Enables the Set up button and disables the Remove button

• Places the window in the inactive state and changes the state icon and title
bar accordingly
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Using the Simulation Control Area 4

The Simulation Control Area is a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-9).

The Simulation Control Area allows you to start, stop, and resume a simulation. It con-
tains three push buttons that you use to perform these functions: the Start button, the
Stop button, and the Resume button.  

Figure 4-23.  Scheduler Window - Simulation Control Area

The Simulation Control Area also contains an icon that indicates whether the simulation is
stopped or running. 

Figure 4-3 illustrates a Scheduler window in which the simulation is running.

The Start button is enabled only when the simulation is stopped. When you click on the
Start button, NightSim carries out the following actions:

• Attaches the timing source to the scheduler if not already attached or if the
timing source has been changed

• If a real-time clock is being used as the timing source, sets the clock period
in accordance with the value entered in the Clock period field in the
Scheduler Configuration Area (see “Clock period” on page 4-27).

• Starts the simulation with the values of the minor cycle, major frame, and
overrun counts set to zero

The Stop button is enabled when the simulation is running. When you click on the Stop
button, NightSim stops the simulation.  When the simulation is stopped, the timing source

When the simulation is stopped, NightSim dis-
plays a stop sign. 

When the simulation is running, NightSim dis-
plays a circle containing the word GO. 
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is not detached from the scheduler, but the Timing source and Clock period fields in
the Scheduler Configuration Area of the Scheduler window are enabled (see pp. 4-25 and
4-27, respectively, for information on these fields). You may wish to change the timing
source, and, if the timing source is a real-time clock, you may wish to change the clock
period.

NOTE 

If you change the timing source, the previously specified timing
source is detached from the scheduler when you click on the
Start or Resume button to start or resume the simulation.

While the simulation is stopped, you may also wish to change one or more of the parame-
ters with which you have scheduled a process on the scheduler.

Although you can also change the parameters with which a process has been scheduled
while the scheduler is running, it is not recommended that you do so.  Rescheduling
requires processor time.  As a result, other processes that are currently scheduled on the
frequency-based scheduler may experience frame overruns.  If you have indicated as such,
the scheduler will halt on a frame overrun but can be resumed.

The Resume button is enabled when the simulation has been running but is currently
stopped.  When you click on the Resume button, NightSim restarts the simulation with
the values of the minor cycle, major frame, and overrun counts the same as they were
when you stopped the simulation.
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Using the Run Status Area 4

The Run Status Area is a part of the Scheduler window (see “Introduction to the Scheduler
Window” on page 4-9).

The Run Status Area shows the number of the current major Frame and the current minor
Cycle for the simulation running on the scheduler.  

Figure 4-24.  Scheduler Window - Run Status Area

This area also contains the following two configurable items:

On Target 

This option menu allows you to select which target system supplies the frame num-
ber and minor cycle count.  This allows you to see each target’s frame and cycle
counts and determine if the schedulers are out of sync.  It also allows you to assign
the work of supplying this information to a target system that may not be as
time-critical as other systems.

Rate

This field allows you to specify the frequency with which the frame and cycle
counts in the Run Status Area are to be updated. Enter the number of seconds to
occur between updates. The minimum value that you may specify is .01 second; the
maximum is 100 seconds.  The default value is 1.0 second.

Figure 4-3 and Figure 4-24 illustrate the Run Status Area for a Scheduler window that is in
the active state. 
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Chapter 5Using the Monitor Window

5
5
5

This chapter describes the performance monitor and explains how to monitor FBS-
scheduled processes, a processor’s idle time, and unscheduled processes. It introduces the
components of NightSim’s Monitor window and describes the use of each component.

Understanding the Performance Monitor 5

The performance monitor is a mechanism that enables you to monitor FBS–scheduled pro-
cesses’ utilization of a CPU.

The performance monitor provides you with the ability to:

• Obtain performance monitor values by process or processor

• Start and stop performance monitoring by process

• Clear performance monitor values by processor

You also have the ability to set the timing mode under which the performance monitor is to
run. You can select one of two modes: one that includes time spent servicing interrupts in
performance monitor timing values and one that excludes time spent servicing interrupts
from those values.

When the performance monitor timing mode is set to include interrupt time, a process’s
user and system times will total the elapsed time that accrues when the process is the
currently running process. This elapsed time includes time spent servicing interrupts and
performing context switches. Time spent servicing interrupts is added to the process’s
system time. Time spent switching to a new process is included in the new process’s
system time.

When the performance monitor timing mode is set to exclude interrupt time, a process’s
user and system times will total the time that accrues when the process is the currently
running process. This time excludes time spent servicing interrupts, but it includes time
spent performing context switches. Time spent switching to a new process is included in
the new process’s system time.

What Values Are Monitored? 5

The performance monitor keeps track of the time that a process spends running from the
time that it is wakened by a frequency–based scheduler until it calls fbswait. Time is
measured in microseconds. One instance of a process’s being wakened by a scheduler is
referred to as an iteration or a cycle. Performance monitor values for FBS–scheduled
processes are reported both in terms of cycles, or iterations, and in terms of major frames.
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They reflect what has happened since the last time that performance monitor values were
cleared and performance monitoring was enabled.

When performance monitoring is enabled for an FBS–scheduled process, NightSim
maintains the following values for each process:

Process Parameters

Target The system on which this process is running

FPID The process’s unique frequency-based scheduler identifier

PID The process’s process identification number

Name The process’s name

Priority The process’s scheduling priority

Starting Cycle The number of the first minor cycle in which the process is
to be wakened in each frame

Period The frequency with which the process is to be wakened in
each major frame

CPU Mask The process’s CPU mask

Interrupt Time Inclusion Indicates whether time spent processing interrupts is
included in performance monitor timing values

General Statistics

Total iterations, cycles The number of times that the process has been wakened by
the scheduler 

Last time The amount of time that the process has spent running from
the last time that it has been wakened by the scheduler until
it has called fbswait 

Total time The total amount of time that the process has spent running
in all cycles 

Average time The average amount of time that the process has spent
running in all cycles, or iterations. This value is obtained by
dividing the value reported in the Total Time column by the
value reported in the Iterations column.

Number of overruns The number of times that the process has caused consecu-
tive "soft" frame overruns, as well as the number of "hard"
frame overruns that the process has caused. 

Percent of period used This value is maintained only if the timing source for the
frequency-based scheduler  on which the process is
scheduled is a real-time clock. It is obtained by dividing the
value reported in the Average Time column by the amount
of time that is available to the process. The amount of time
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available to the process is calculated from its period and the
length of a clock cycle.

Minimum Values

Minimum cycle time The least amount of time that the process has spent running
in a cycle

Minimum cycle frame The number of the major frame in which the minimum cycle
time has occurred

Minimum cycle cycle The number of the minor cycle in which the minimum cycle
time has occurred

Minimum frame time The least amount of time that the process has spent running
during a major frame

Minimum frame frame The number of the major frame in which the minimum
frame time has occurred

Maximum Values

Maximum cycle time The greatest amount of time that the process has spent
running in a cycle

Maximum cycle frame The number of the major frame in which the maximum
cycle time has occurred

Maximum cycle cycle The number of the minor cycle in which the maximum cycle
time has occurred

Maximum frame time The greatest amount of time that the process has spent
running during a major frame

Maximum frame frame The number of the major frame in which the maximum
frame time has occurred

Monitoring Idle Time 5

The performance monitor provides you with the capability of monitoring a processor’s
idle time. Idle time refers to the time that the CPU is not busy.  By monitoring a proces-
sor’s idle time, you can determine the amount of CPU time that is available to be allocated
to additional processes. 

Procedures for monitoring idle time is described in “How Is Idle Time Monitored?”

How Is Idle Time Monitored? 5

You can monitor a particular processor’s idle time if you add the process /idle to a
frequency–based scheduler and schedule it on the desired processor.  You can also moni-
tor idle time for a number of different processors by adding /idle to a selected fre-
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quency–based scheduler more than once and scheduling it on a different processor each
time. Furthermore, you can add /idle to more than one frequency–based scheduler.  

NOTE

It is important to note that you can schedule /idle on a particu-
lar processor for a particular target only once.  This is a system-
wide restriction.  Only one user per processor per target may
schedule /idle.

To add /idle to a frequency–based scheduler, use the Process Scheduling Area of the
Scheduler window (see “Using the Process Scheduling Area” on page 4-28 for details).
For an explanation of the procedures for adding a program to a scheduler, refer to
Chapter 4, “Using the Scheduler Window.”

When you use NightSim to add /idle to a frequency–based scheduler, the only parame-
ter that you may specify is the CPU mask. The CPU mask for /idle must specify only
one CPU. The default scheduling priority is zero. The starting base cycle is zero, and the
period is one. /idle will be scheduled every minor cycle, starting with the first minor
cycle in each major frame.

You can view scheduling information for /idle in the same way that you view it for
other FBS–scheduled processes––in the Process Scheduling Area of the Scheduler win-
dow (see “Using the Process Scheduling Area” on page 4-28 for details). For an illustra-
tion that shows this area, refer to Figure 4-3 in Chapter 4, “Using the Scheduler Win-
dow.”.

Monitoring Unscheduled Processes 5

The performance monitor provides you with the additional capability of monitoring the
performance of unscheduled processes. Unscheduled processes are those that are not
wakened by the scheduler and do not call fbswait; they are not scheduled to run at a
certain frequency. To be able to obtain performance monitor values for such processes,
you must first add them to a frequency–based scheduler and specify a starting base cycle
of zero and a period of zero. The other scheduling parameters that you must specify
include the process’s scheduling priority and the CPU on which it is to be scheduled. You
can optionally specify a decimal value to be passed to a process that is scheduled on a
frequency–based scheduler. The Halt FBS on frame overrun flag does not apply to
an unscheduled process (see “Overrun” on page 4-34).

You can add unscheduled processes to a frequency–based scheduler by using the Process
Scheduling Area of the Scheduler window (see “Using the Process Scheduling Area” on
page 4-28 for details). For an explanation of the procedures for adding a program to a
scheduler, refer to Chapter 4, “Using the Scheduler Window.”

You can view scheduling information for unscheduled processes in the same way that you
view it for other FBS–scheduled processes––in the Process Scheduling Area of the Sched-
uler window (see “Using the Process Scheduling Area” on page 4-28 for details). For an
illustration that shows this area, refer to Figure 4-3 in Chapter 4, “Using the Scheduler
Window.”.
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The performance monitor values that are maintained for unscheduled processes include
the following:

• Total time

You can obtain this value if you enable performance monitoring for the processes.
Procedures for enabling performance monitoring and retrieving performance monitor
values are described in detail in “Monitor” on page 5-8.
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Introduction to the Monitor Window 5

The Monitor window allows you to start and stop performance monitoring on FBS-sched-
uled processes scheduled on one or more processors, clear performance monitor values for
all FBS-scheduled processes scheduled on one or more processors, and display perfor-
mance monitor values for selected FBS-scheduled processes.

The Monitor window consists of the following components:

• Menu Bar (see “Using the Monitor Window Menu Bar” on page 5-7) 

• Status Area (see “Using the Status Area” on page 5-22) 

• Output Area (see “Using the Output Area” on page 5-23) 

• Output Control Area (see “Using the Output Control Area” on page 5-24) 

Figure 5-1 identifies the location of each of these components in the Monitor window.
Note that this window contains sample data associated with a scheduler that exists on the
system.

Figure 5-1.  Sample Monitor Window

Procedures for using each component of the Monitor window are described in the sections
that follow.

Menu 
Bar

Status 
Area

Output 
Area

Output 
Control 
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Using the Monitor Window Menu Bar 5

The Monitor window menu bar is a part of the Monitor window (see “Introduction to the
Monitor Window” on page 5-6).

The Monitor window menu bar provides access to the following menus: 

• NightSim (see “NightSim” on page 5-7) 

• Monitor (see “Monitor” on page 5-8) 

• Output (see “Output” on page 5-13) 

• View (see “View” on page 5-15) 

• Tools (see “Tools” on page 5-21) 

• Help (see “Help” on page 5-21) 

Each menu is described in the sections that follow.

NightSim 5

The NightSim menu appears on the Monitor window menu bar (see “Using the Monitor
Window Menu Bar” on page 5-7).

The NightSim menu on the Monitor window contains commands related to the global
operation of NightSim.  Figure 5-2 presents this menu.

Figure 5-2.  NightSim Menu

Descriptions of the options on the NightSim menu follow.

Create Scheduler Window

This option allows you to create a new Scheduler window.  If this option is selected
from a Monitor window which is associated with an existing scheduler, the new
Scheduler window is created as an active window and all information associated
with the Monitor window, including the target and scheduler key, is copied to this
new Scheduler window.  
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Create Monitor Window

This option allows you to create a new Monitor window. The new window will not
be associated with a particular frequency-based scheduler.

Duplicate Window

This option allows you to create a new Monitor window with the same configuration
as that of the Monitor window from which this option was selected. Note that if per-
formance monitor values are currently being logged to one or more files, the new
Monitor window will not be associated with those files.

Close Window

This option allows you to close the current Monitor window. 

If performance monitor values are being logged to a file, NightSim requires that you
close this file before proceeding. 

Exit

This option allows you to exit NightSim. If you have open Scheduler windows that
are untitled and contain unsaved changes, NightSim displays a warning dialog. In
each case, you may save the changes, close the window without saving the changes,
cancel the close operation, or display help related to the dialog. If you click on the
Yes button to save the changes, NightSim displays a file selection dialog.

If you have open a Scheduler window that is associated with a configuration file
name and contains unsaved changes, NightSim displays a warning dialog. If you
click on the Yes button, the changes are saved in the file associated with the win-
dow.

The warning dialogs are displayed for each window that contains unsaved changes.

If performance monitor values are being logged to one or more files, NightSim dis-
plays a warning dialog. You may confirm that you wish to stop logging and close the
file, continue to keep the window open, or display help related to the dialog.

If a scheduler is currently active, NightSim display a confirmation dialog that allows
you to exit and leave the scheduler active, or to cancel the exit action.

Monitor 5

The Monitor menu appears on the Monitor window menu bar (see “Using the Monitor
Window Menu Bar” on page 5-7).

The Monitor  menu contains general commands related to performance monitoring.
Figure 5-3 presents this menu.
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Figure 5-3.  Monitor Menu

Descriptions of the options on the Monitor menu follow.

Select Active Scheduler . . . 

This option allows you to associate the current Monitor window with a frequency-
based scheduler active on a given target system. When you select this option, Night-
Sim displays Figure 4-6, “Select Active Scheduler Dialog,” (see p. 4-15 of
Chapter 4 for an explanation of this dialog). 

This dialog provides a list of the active schedulers for the system designated by the
Target field.  The Target defaults to your local SBC and the list contains the active
schedulers running on that particular system.  For instance, Figure 4-6 lists the two
schedulers currently running on the target amber2.

You may change the Target either by using the drop-down list (which lists the tar-
gets in your cluster) or by typing the name of the target system into the text field
provided.  Entering an item in this field will populate the list with the active sched-
ulers on the specified target.

You may select a scheduler from the list that the dialog displays, or you may use the
Scheduler Key  text field to enter the numeric key that is associated with the
desired scheduler. The key can be any positive integer value. Whether you select
from the list or enter a key, the selected scheduler must previously have been
configured, and you must have at least read permission for it; otherwise, NightSim
reports an error.

If you successfully select an existing scheduler, the Monitor window is associated
with that scheduler.

If performance monitor values are being logged to one or more files, NightSim asks
you if you wish to stop the logging and close the files.  You may confirm that you
wish to stop logging and close the file, continue to keep the window open, or display
help related to the dialog.  If the window from which you select Select Active
Scheduler . . . is the only window that you have open, NightSim displays a warn-
ing dialog.
5-9



NightSim RT User’s Guide
Associate Scheduler Window . . .

This dialog box allows you to associate a Monitor window with an existing sched-
uler.  The dialog lists the scheduler key and the target systems to which processes are
assigned for each Scheduler window in the current NightSim session.  Select one of
these schedulers by clicking on it and pressing OK, or press Cancel to close the
dialog and leave the Monitor window unchanged.

Figure 5-4.  Select Associated Scheduler Window Dialog

Select Target and Key . . .

This dialog allows you to associate a Monitor window with a scheduler by specify-
ing the Target System where the scheduler resides and its Scheduler Key.  The
scheduler need not already exist.  If it does not exist but the scheduler is created in
this session of NightSim, the Monitor window will automatically start monitoring
that scheduler when the scheduler is created and started by NightSim.

Figure 5-5.  Select Target System and Key Dialog
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Enable/Disable Monitoring . . . 

This option allows you to enable or disable performance monitoring for one or more
processes that are scheduled on the selected scheduler.  By default, performance
monitoring is enabled for all FBS-scheduled processes. 

When you select this option, NightSim displays the selection dialog that Figure 5-6
presents.

Figure 5-6.  Enable/Disable Monitoring Dialog

Enable/Disable Monitoring List

This list contains all of the processes that are scheduled on the scheduler and indi-
cates whether or not performance monitoring is currently enabled for each process.
You may use the mouse to select the process or processes for which you wish to
enable or disable performance monitoring and then click on the Enable or Dis-
able button as desired.

You may also use a combination of the following items to specify those processes for
which you wish performance monitoring enabled or disabled:

FPID:

You may specify the unique frequency-based scheduler process identifier of a pro-
cess for which you wish performance monitoring enabled or disabled.

Program Name:

You may specify the name of the process for which you wish performance monitor-
ing enabled or disabled.  Enter a full or relative pathname.  The pathname must be
valid on the target system to which this process is assigned.

CPU Mask:

This panel of check buttons allows you to Enable or Disable performance moni-
toring for processes that are scheduled on the specified processor or processors.
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Click on one or more buttons, where the label 0 represents the first logical CPU, 1
represents the second, and so on.  To select all CPUs on your system, click on the
All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, NightSim
reports an error. If more than one FBS-scheduled process with the specified identifier(s)
exists, all such processes are shown or hidden.

Enable

Enables performance monitoring for those processes either selected in the
Enable/Disable Monitoring List or specified using FPID, Program Name,
or CPU Mask.

Disable

Disables performance monitoring for those processes either selected in the
Enable/Disable Monitoring List or specified using FPID, Program Name,
or CPU Mask.

Include Interrupt Time

This item allows you set the timing mode under which the performance monitor is to
run, indicating that time spent processing interrupts is to be included in perfor-
mance monitor timing values.  This is a system-wide setting that affects all pro-
cesses on the target systems that have processes attached to the specified scheduler.

This status may be displayed by selecting the Interrupt Time Inclusion check-
box in the Custom Display dialog from the View menu (see Figure 5-10 on page
5-15).  The Output Area in the Monitor window will then report this status for each
process (see “Using the Output Area” on page 5-23 for related information).

Exclude Interrupt Time

This item allows you to set the timing mode under which the performance monitor is
to run, indicating that time spent processing interrupts is to be excluded from per-
formance monitor timing values.  This is a system-wide setting that affects all pro-
cesses on the target systems that have processes attached to the specified scheduler.

This status may be displayed by selecting the Interrupt Time Inclusion check-
box in the Custom Display dialog from the View menu (see Figure 5-10 on page
5-15).  The Output Area in the Monitor window will then report this status for each
process (see “Using the Output Area” on page 5-23 for related information).

Clear Performance Values . . . 

This option allows you to clear performance monitor values for all FBS-scheduled
processes on one or more processors.  Note that values are cleared for selected CPUs
on all target systems that have processes attached to the specified scheduler.

When you select this option, NightSim displays the dialog that Figure 5-7 presents.
5-12



Using the Monitor Window
Figure 5-7.  Clear Performance Monitor Values Dialog

By default, All CPUs is selected, so that you may conveniently clear all perfor-
mance monitor values for all CPUs by simply pressing Enter or clicking OK.

You use the panel of check buttons to select the processor or processors for which
you wish to clear performance monitor values. Click on one or more buttons, where
the label 0 represents the first logical CPU, 1 represents the second, and so on. To
select all CPUs on your system, click on the All CPUs button. After selecting the
processor(s), you may apply your selection, cancel the operation, or display help
related to the dialog. 

Output 5

The Output menu appears on the Monitor window menu bar (see “Using the Monitor
Window Menu Bar” on page 5-7).

The Output menu controls where performance data is to be sent.  Figure 5-8 presents this
menu.

Figure 5-8.  Output Menu

A checkmark appears next to an item if it is enabled.  The two items can be enabled or dis-
abled independently.  Descriptions of these options follow.

To Screen

This toggle button allows you to indicate whether or not performance monitoring
values are to be displayed in the Output Area of the Monitor window (see “Using
the Output Area” on page 5-23 for related information).

To Text File . . . 

This option allows you to (1) specify the name of a text file in which you wish per-
formance monitor values to be saved and (2) specify the types of values to be saved.
When you select this option, NightSim displays a file selection dialog to specify the
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name of the text file.To select the file in which values are to be saved, use the direc-
tory text area, file mask area, list of directories, list of files, and file selection text
area as appropriate. To specify the types of values to be saved, use the Fields to
output option menu that Figure 5-9 presents.

Figure 5-9.  Fields to Output Option Menu

Descriptions of the options contained in the Fields to output option menu follow.  

Summary Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask) and general statistics.
Refer to “What Values Are Monitored?” on page 5-1 for a complete descrip-
tion of all types of performance monitor values.

Minimum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions), and minimum values. Refer to “What Values Are Monitored?” on page
5-1 for a complete description of all types of performance monitor values.

Maximum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions), and maximum values. Refer to “What Values Are Monitored?” on page
5-1 for a complete description of all types of performance monitor values.

All Fields

This option specifies all types of values: target system, process scheduling
parameters, general statistics, minimum values, and maximum values. Refer
to “What Values Are Monitored?” on page 5-1 for a complete description of
all types of performance monitor values.

Custom . . . 

This option allows you to select any of the types of values that the perfor-
mance monitor facility maintains.
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When you select this option, NightSim displays the dialog that Figure 5-10
presents.

Figure 5-10.  Custom Display Dialog Box

You use the panels of check buttons to select the types of performance moni-
tor values that you wish to save. Click on one or more buttons as desired.
After you have selected the types of values that you wish to save, you may
apply the selections and close the Custom Display dialog box, cancel the
selections, or display help related to the dialog.

After selecting the file in which values are to be saved and specifying the
types of values to be saved, you may save the values in the selected file,
search for another file, cancel the operation, or display help related to the dia-
log. 

View 5

The View menu appears on the Monitor window menu bar (see “Using the Monitor Win-
dow Menu Bar” on page 5-7).

The View menu controls output to the Monitor window.  Figure 5-11 presents this menu.
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Figure 5-11.  View Menu

Descriptions of the options on the View menu follow.

Select Processes. . .   

This option allows you to specify the FBS-scheduled processes whose performance
monitor values will be reported.  

Depending on the selection under the Output menu (see “Output” on page 5-13),
performance monitor values will be displayed in:

• the Output Area of the Monitor window if the “To Screen” option
is selected (see “Using the Output Area” on page 5-23 for more
information)

• a text file if the “To Text File...” option is selected

Note that performance monitoring must be enabled for a process in order for it to be
shown in the Monitor window.  Performance monitoring is enabled for all processes
by default.

When you choose the Select Processes . . . option, NightSim displays the dia-
log in Figure 5-12:

Figure 5-12.  Select Processes to View Dialog
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Select Processes List

This list contains all of the processes that are scheduled on the scheduler and
indicates whether or not their performance values will be reported. You may
use the mouse to select the process or processes whose performance values
you wish to Show or Hide.

You may also use a combination of the following items to specify which processes
you wish to Show or Hide:

FPID:

You may specify the unique frequency-based scheduler process identifier for a
process whose performance values you wish to Show or Hide.

Program Name:

You may specify the name of the process that you wish to Show or Hide.
Enter a full or relative pathname.  The pathname must be valid on the target
system to which this process is assigned.

CPU Mask:

This panel of check buttons allows you to Show or Hide processes which are
scheduled on the specified processor or processors. Click on one or more but-
tons, where the label 0 represents the first logical CPU, 1 represents the sec-
ond, and so on.  To select all CPUs on your system, click on the All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, Night-
Sim reports an error. If more than one FBS-scheduled process with the specified
identifier(s) exists, all such processes are shown or hidden.

Show

Reports the performance monitor values for those processes either selected in
the Select Processes List or specified using FPID, Program Name, or
CPU Mask .

Hide

Refrains from reporting the performance monitor values for those processes
either selected in the Select Processes List or specified using FPID,
Program Name, or CPU Mask .

Display Fields

This option allows you to specify the types of performance monitor values that are
to be displayed in the Output Area of the Monitor window (see “Using the Output
Area” on page 5-23 for related information). When you select this option, NightSim
displays the tear-off menu that Figure 5-13 presents.
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Figure 5-13.  Display Fields Tear-Off Menu

Descriptions of the options contained in the Display Fields tear-off menu follow.

Summary Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask) and general statistics.
Refer to “What Values Are Monitored?” on page 5-1 for a complete descrip-
tion of all types of performance monitor values.

Minimum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions) and minimum values. Refer to “What Values Are Monitored?” on page
5-1 for a complete description of all types of performance monitor values.

Maximum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions) and maximum values. Refer to “What Values Are Monitored?” on page
5-1 for a complete description of all types of performance monitor values.

All Fields

This option specifies all types of values: target system, process scheduling
parameters, general statistics, minimum values, and maximum values. Refer
to “What Values Are Monitored?” on page 5-1 for a complete description of
all types of performance monitor values.

Custom . . . 

This option allows you to select any of the types of values that the perfor-
mance monitor facility maintains. 

When you select this option, NightSim displays the dialog that Figure 5-10
presents.

You use the panels of check buttons to select the types of performance moni-
tor values that you wish to display. Click on one or more buttons as desired.
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After you have selected the types of values that you wish to display, you may
apply the selections and close the Custom Display dialog box, apply the
selections without closing the dialog box, cancel the selections, or display
help related to the dialog.

Sort By

This option allows you to select the primary sort key used in ordering the FBS-
scheduled processes and associated performance monitor values. (Refer to “Output”
on page 5-13 for information on specifying where these values are reported.)

When you select this option, NightSim displays the tear-off menu that Figure 5-14
presents.

Figure 5-14.  Sort By Tear-Off Menu

You specify the type of value to be used as the primary sort key by clicking on the
desired radio button. It is important to note that the first seven options are separated
from the others. The reason is that with the first seven options, the sort order must be
calculated only once. With the other options, the sort order must be recalculated
each time you query the values. As a result, the overhead associated with the first
seven options is far less than that associated with the others.

The default is Target System.
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Then Sort By

This option allows you to indicate the secondary sort key to be used in ordering the
FBS-scheduled processes and associated performance monitor values. (Refer to
“Output” on page 5-13 for information on specifying where these values are
reported.)  The Sort By and Then Sort By options allow you to sort first on a
value such as priority and then sort again within that grouping by a value such as
average time.

When you select this option, NightSim displays the tear-off menu that Figure 5-15
presents.

Figure 5-15.  Then Sort By Tear-Off Menu

You specify the type of value to be used as the secondary sort key by clicking on the
desired radio button or you may choose the first option, None, to have no second-
ary sort key.  It is important to note that the next eight options are separated from the
others. The reason is that with those eight options, the sort order must be calculated
only once. With the other options, the sort order must be recalculated each time you
query the values. As a result, the overhead associated with the eight options is far
less than that associated with the other options.

The default is FPID.
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Resolution

This option allows you to control the precision with which NightSim reports the
performance monitor timing values. When you select this option, NightSim displays
the tear-off menu that Figure 5-16 presents.

Figure 5-16.  Resolution Options

You may specify the precision in microseconds, tens of microseconds, hundreds of
microseconds, milliseconds, or tens of milliseconds by clicking on the toggle button
and choosing the desired option.

NOTE

As the values of times increase in a long-running simulation, the
resolution option value is automatically increased by NightSim in
order to avoid overflowing the display.

Tools 5

The Tools menu appears on the Monitor window menu bar (see “Using the Monitor Win-
dow Menu Bar” on page 5-7) as well as on the Scheduler window menu bar (see “Using
the Scheduler Window Menu Bar” on page 4-11).

The Tools menu contains a list of other NightStar tools that can be launched directly from
NightSim.

See “Tools” on page 4-20 for detailed information about this menu and each of its items.

Help 5

The Help menu appears on the Monitor window menu bar (see “Using the Monitor Win-
dow Menu Bar” on page 5-7) as well as on the Scheduler window menu bar (see “Using
the Scheduler Window Menu Bar” on page 4-11).

The Help menu provides access to the on-line help system.  See “Getting Help” on page
3-3 for detailed information about this menu and each of its items.
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Using the Status Area 5

The Status Area is a part of the Monitor window (see “Introduction to the Monitor Win-
dow” on page 5-6).

The Status Area displays information about the frequency-based scheduler with which this
Monitor window is associated. 

Figure 5-17.  Monitor Window - Status Area

It contains the following values:

Target

This field displays the target system on which the scheduler associated with this
Monitor window resides.

Together with the Scheduler Key, this Target  system serves to identify the
scheduler to NightSim.

Scheduler Key

This field displays the numeric key for the scheduler with which this Monitor win-
dow is associated.

If the frequency-based scheduler with which the Monitor window is associated is an active
scheduler, the Status Area also shows:

Frame

Current major frame of the associated frequency-based scheduler.

Cycle

Current minor cycle of the associated frequency-based scheduler.
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The Status Area also contains two icons: one that indicates the current state of the sched-
uler and one that indicates the current state of the simulation. 

Figure 5-17 illustrates the Status Area for a Monitor window that is associated with an
active scheduler and a running simulation.

Using the Output Area 5

The Output Area is a part of the Monitor window (see “Introduction to the Monitor Win-
dow” on page 5-6).

The Output Area contains a textual display of performance monitor information.

Figure 5-18.  Monitor Window - Output Area

When the scheduler is inactive, NightSim shows
an unplugged connection. 

When the scheduler is active, it shows a plugged
connection.

When the simulation is stopped, NightSim dis-
plays a stop sign. 

When the simulation is running, it displays a cir-
cle containing the word GO.
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The Output Area allows you to view performance monitor values for selected FBS-
scheduled processes. It contains a scrolling list of the processes that are currently
scheduled on the frequency-based scheduler with which the Monitor window is associated
and that have been selected for performance monitoring. You can use the horizontal and
vertical scroll bars to scroll the visible contents of the area. Although you cannot edit this
area of the Monitor window, you can use the mouse to select text in the area and paste it in
another window—one in which an editor is running, for example.

NOTE

If the Priority, Period , or CPU Bias mask of a process are
changed while the scheduler is running, the Monitor window will
not reflect the updated values until the next Monitor window
update after the process runs again.

For information on the commands that allow you to control the operation of the perfor-
mance monitor, refer to “Monitor” on page 5-8. For information on the commands that
allow you to control the information that is displayed in the Output Area, refer to “View”
on page 5-15.

Using the Output Control Area 5

The Output Control Area is a part of the Monitor window (see “Introduction to the Moni-
tor Window” on page 5-6).

The Output Control Area allows you to specify the frequency and precision with which
you wish performance monitor values to be updated.   Note that the selections that you
make in the Output Control Area apply both to the values displayed in the Output Area of
the Monitor window (see “Using the Output Area” on page 5-23) and the values saved in a
file.  See “Output” on page 5-13 for related information.

Figure 5-19.  Monitor Window - Output Control Area

The Output Control Area contains the following text field and controls:

Repetitive Query

This check button allows you to indicate that you wish NightSim to repeatedly
query performance monitor values at a rate that you specify in the Rate text field in
the Output Control Area. If this button is activated and the simulation on the fre-
quency-based scheduler associated with the Monitor window has not been started,
NightSim will query the target system (designated in the Target field of the Moni-
tor window) at the specified Rate to detect when the scheduler gets started.
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Note that once the scheduler is active, NightSim must query every target system to
which processes have been assigned to obtain the complete set of performance data.
This may affect the performance of those target systems to some degree.

Rate

This field allows you to specify the frequency with which performance monitor
values are to be updated.  Enter the number of seconds to occur between updates.
The minimum value that you may specify is 0.01 second and the maximum is 100
seconds.  The default value is 1.0 second.

Query Now

This push button allows you to query performance monitor values immediately.

Resolution of Times

This displays the resolution of the times displayed by the performance monitor.
This resolution is controlled by the Resolution item in the View  menu.  See
“View” on page 5-15 for more information.
5-25



NightSim RT User’s Guide
5-26



A
Appendix ANightStar Licensing

A
A
A

NightStar RT uses the NightStar License Manager (NSLM) to control access to the Night-
Star RT tools.

License installation requires a licence key provided by Concurrent The NightStar RT tools 
request a licence (see “License Requests” on page A-2) from a license server (see 
“License Server” on page A-2).

Two license modes are available, fixed and floating, depending on which product option 
you purchased.  Fixed licenses can only be served to NightStar RT users from the local 
system.  Floating licenses may be served to any NightStar RT user on any system on a net-
work.

Tools are licensed per system, per concurrent user.  A single license is shared among any 
or all of the NightStar RT tools for a particular user on a particular system.  The intent is to 
allow n developers to fully utilize all the tools at the same time while only requiring n
licenses.  When operating the tools in remote mode, where a tool is launched on a local 
system but is interacting with a remote system, licenses are required only from the host 
system.

You can obtain a license report which lists all licenses installed on the local system, cur-
rent usage, and expiration date for demo licenses (see “License Reports” on page A-3).

The default Red Hat Enterprise Linux configuration includes a strict firewall which inter-
feres with floating licenses.  See “Firewall Configuration for Floating Licenses” on page 
A-3 for information on handling such configurations.

License Keys 1

Licenses are granted to specific systems to be served to either local or remote clients, 
depending on the license model, fixed or floating.

License installation requires a license key provided by Concurrent.  To obtain a license 
key, you must provide your system identification code.  The system identification code is 
generated by the nslm_admin utility:

nslm_admin --code

System identification codes are dependent on system configurations. Reinstalling Linux 
on a system or replacing network devices may require you to obtain new license keys.

To obtain a license key, use the following URL:

http://www.ccur.com/NightStarRTKeys
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Provide the requested information, including the system identification code. Your license 
key will be immediately emailed to you.

Install the license key using the following command:

nslm_admin --install=xxxx-xxxx-xxxx-xxxx-xxxx

where xxxx-xxxx-xxxx-xxxx-xxxx is the key included in the license acknowledgment email.

License Requests 1

By default, the NightStar RT tools request a license from the local system.  If no licenses 
are available, they broadcast a license request on the local subnet associated with the sys-
tem’s hostname.  

You can control the license requests for an entire system using the /etc/nslm.config
configuration file.

By default, the /etc/nslm.config file contains a line similar to the following:

:server @default

The argument @default may be changed to a colon-separated list of system names, system 
IP addresses, or broadcast IP addresses. Licenses will be requested from each of the enti-
ties found in the list, until a license is granted or all entries in the list are exhausted.

For example, the following setting prevents broadcast requests for licenses, by only speci-
fying the local system:

:server localhost

The following setting requests a license from server1, then server2, and then a 
broadcast request if those fail to serve a license:

:server server1:server2:192.168.1.0

Similarly, you can control the license requests for individual invocations of the tools using 
the NSLM_SERVER environment variable.  If set, it must contain a colon-separated list of 
system names, system IP addresses, or broadcast IP addresses as described above.  Use of 
the NSLM_SERVER environment variable takes precedence over settings defined in 
/etc/nslm.config.

License Server 1

The NSLM license server is automatically installed and configured to run when you install 
NightStar RT

The nslm service is automatically activated for run levels 2, 3, 4, and 5. You can check on 
these settings by issuing the following command:
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/sbin/chkconfig --list nslm

In rare instances, you may need to restart the license server via the following command:

/sbin/service nslm restart

See nslm(1) for more information.

License Reports 1

A license report can be obtained using the nslm_admin utility.

nslm_admin --list

lists all licenses installed on the local system, current usage, and expiration date (for demo 
licenses). Use of the --verbose option also lists individual clients to which licenses are 
currently granted.

Adding the --broadcast option will list this information for all servers that respond to 
a broadcast request on the local subnet associated with the system’s hostname.

See nslm_admin(1) for more options and information.

Firewall Configuration for Floating Licenses 1

The default Red Hat Enterprise Linux configuration includes a strict firewall which inter-
feres with floating licenses.

If such a system is used to serve licenses, then at least one port must be opened in its fire-
wall to allow server requests to pass.  See “Serving Licenses with a Firewall” on page A-3
for more information.  

Similarly, if such a system is host to the NightStar RT tools, then at least one port must be 
opened in its firewall so that it can receive licenses from the license server.  If this is not 
done, a tool requesting a floating license will not receive it and will not function properly. 
See “Running NightStar RT Tools with a Firewall” on page A-5 for more information.

Serving Licenses with a Firewall 1

Following are a few approaches for allowing the NSLM license server to serve floating 
licences when the system on which it is running is configured with a firewall:

• disable the firewall on the system entirely

• allow NSLM license requests from a specific system (or one of several)
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• allow NSLM license requests from any system on a particular subnet (or 
one of several)

• allow NSLM license requests from any system

NOTE

You must be root in order to modify the firewall configuration.

To disable the firewall entirely, execute:

service iptables stop

and then remove the /etc/sysconfig/iptables file:

rm -f /etc/sysconfig/iptables

This option may not be as dangerous as it seems.  Often, whole networks are protected 
with a firewall so it is not necessary for individual systems on the network to be protected 
further.  If unsure, check with your network administrator.

Fo r  t h e  r ema in i ng  cases ,  a  s im p le  m od i f i ca t ion  shou ld  be  m ade  to  t he  
/etc/sysconfig/iptables file.  By default, that file should contain a line like the 
following:

-A RH-Firewall-1-INPUT -j REJECT --reject-with icmp-host-prohibited

To allow NSLM license requests from a specific system, insert the following lines before 
the REJECT line:

-A RH-Firewall-1-INPUT -p udp -m udp -s system --dport 25517 -j ACCEPT
-A RH-Firewall-1-INPUT -p tcp -m tcp -s system --dport 25517 -j ACCEPT

Those lines can be repeated for multiple systems.

To allow NSLM license requests from any system on a particular subnet, insert the follow-
ing lines before the REJECT line:

-A RH-Firewall-1-INPUT -p udp -m udp -s subnet/mask --dport 25517 -j ACCEPT
-A RH-Firewall-1-INPUT -p tcp -m tcp -s subnet/mask --dport 25517 -j ACCEPT

The subnet might be of a form like 192.168.1.0 and the mask could be a traditional 
network mask like 255.255.255.0 or a single number like 24, which indicates the 
n u m b e r  o f  b i t s  f r o m  t h e  l e f t  t h a t  a r e  p a r t  o f  t h e  m a s k .  F o r  e x a m p l e ,  
192.168.1.0/255.255.255.0 and 192.168.1.0/24 are equivalent.

Those lines can be repeated for multiple subnets.
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To allow NSLM license requests from any system, insert the following lines before the 
REJECT line:

-A RH-Firewall-1-INPUT -p udp -m udp --dport 25517 -j ACCEPT
-A RH-Firewall-1-INPUT -p tcp -m tcp --dport 25517 -j ACCEPT

After modifying /etc/sysconfig/iptables, execute:

service iptables restart

Running NightStar RT Tools with a Firewall 1

Following are a few approaches for allowing a NightStar RT tool to receive floating 
licenses from a license server, when the system running the NightStar RT tool is config-
ured with a firewall:

• disable the firewall on the requesting system entirely

• allow NSLM licenses from a specific license server (or one of several)

• allow NSLM licenses from any system on a particular subnet (or one of 
several)

• allow NSLM licenses from any system

NOTE

You must be root in order to modify the firewall configuration.

To disable the firewall entirely, execute:

service iptables stop

and then remove the /etc/sysconfig/iptables file:

rm -f /etc/sysconfig/iptables

This option may not be as dangerous as it seems. Often, whole networks are protected 
with a firewall so it is not necessary for individual systems on the network to be protected 
further.  If unsure, check with your network administrator.

Fo r  t h e  r ema in i ng  cases ,  a  s im p le  m od i f i ca t ion  shou ld  be  m ade  to  t he  
/etc/sysconfig/iptables file.  By default, that file should contain a line like the 
following:

-A RH-Firewall-1-INPUT -j REJECT --reject-with icmp-host-prohibited

To allow NSLM licenses from a specific system running a license server, insert the follow-
ing line before the REJECT line:

-A RH-Firewall-1-INPUT -p udp -m udp -s server --sport 25517 -j ACCEPT

That line can be repeated for multiple servers.
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To allow NSLM licenses from any system running a license server on a particular subnet, 
insert the following before the REJECT line:

-A RH-Firewall-1-INPUT -p udp -m udp -s subnet/mask --sport 25517 -j ACCEPT

The subnet might be of a form like 192.168.1.0 and the mask could be a traditional 
network mask like 255.255.255.0 or a single number like 24, which indicates the 
n u m b e r  o f  b i t s  f r o m  t h e  l e f t  t h a t  a r e  p a r t  o f  t h e  m a s k .  F o r  e x a m p l e ,  
192.168.1.0/255.255.255.0 and 192.168.1.0/24 are equivalent.

That line can be repeated for multiple subnets.

To allow NSLM licenses from any system running a license server, insert the following 
line before the REJECT line:

-A RH-Firewall-1-INPUT -p udp -m udp --sport 25517 -j ACCEPT

After modifying /etc/sysconfig/iptables, execute:

service iptables restart

License Support 1

For additional aid with licensing issues, contact the Concurrent Software Support Center 
at our toll free number 1-800-245-6453.  For calls outside the continental United States, 
the number is 1-954-283-1822.  The Software Support Center operates Monday through 
Friday from 8 a.m. to 5 p.m., Eastern Standard Time.  

You may also submit a request for assistance at any time by using the Concurrent Com-
puter Corporation web site at http://www.ccur.com/isd_support_contact.asp or by send-
ing an email to support@ccur.com.
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Appendix BConfiguration Files

This appendix discusses the format of configuration files used by NightSim as well as the
automatic conversion of configuration files created by NightSim 2.4 and earlier versions.

Configuration File Format 2

NightSim 2.4 and earlier versions allowed the user to save the configuration as a sequence
of rtcp commands to a file that could be run as a script in place of using NightSim.  The
concept of a distributed FBS introduced in NightSim 3.2, allowing for processes to be
scheduled in a synchronized manner on more than one target computer, makes this form
less desirable, as well as less efficient.  The configuration is now saved to a file with the
following format:

Scheduler <key> {
   cycles <n>;                   // cycles per frame
   tasks total <n>;              // total number of tasks allowed in scheduler
   tasks per cycle <n>;          // optional, defaults to total tasks
   permissions owner=<perms>;    // permissions, see below
   distribution <dist_kind>;     // distribution kind, see below

   timing source {
      host "<name>";             // timing-host name
      EOC ;                      // if end-of-cycle timing
      clock "<name>";            // if rtc, simple name of clock
      eti "<name>";              // if eti, simple name of eti
      other "<name>";            // full pathname of device
      clock duration <n>;        // if rtc, clock duration in microseconds
      clock count <n>;           // if rtc, ticks per minor cycle.
   }

   process "<program_name>" on "<target_name>" {
      NightView <boolean> ;      // schedule under NightView, {True | False}
      xterm <boolean> ;          // run under an xterm(1), {True | False}
      dir "<name>" ;             // full pathname of working directory on target
      input <style> ;            // input source, {File | Standard}
      infile "name" ;            // full pathname of input file
      output <style> ;           // output destination, {File | Standard}
      outfile "<name>" ;         // full pathname of output file
      privilege "<privlist>" ;   // working privileges, see below
      policy <p>;                // scheduling policy, p = {R | O | P}
      priority <n>;              // scheduling priority
      parameter <n>;             // program parameter.  if absent, -1
      soft overruns <n>;         // soft overrun limit.  if absent, no limit
      cpu <mask>;                // cpu bias mask, see below
      start cycle <n>;           // starting cycle
      period <n>;                // period
   } ...

}

NOTE

T h e  v a l u e s  f o r  <name> ,  <program_name> ,
<target_name>, and <privlist> must be enclosed in dou-
ble quotes (")
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The <perms> specification is a sequence of one or more of the following:

owner=<permspec>
group=<permspec>
other=<permspec>

where <permspec> is either ’r’, ’w’, or ’rw’.

The <dist_kind> specification is one of the following values:

“None” target names must match the timing-host name

“Closely Coupled” targets must be in the same cluster as timing-host

“RCIM Coupled” targets are on the same RCIM chain as timing-host.

The <boolean> specifications should have a simple boolean keyword:

True the feature is enabled

False the feature is disabled

The <style> specifications should have one of the following values:

File input/output should be redirected from/to a file on the
target system.  A name must be provided.

Standard I/O should be performed to/from standard I/O streams,
Standard Input, or Standard Error.

NOTE

If both xterm and NightView boolean parameters are False,
then the <style> specifications for input and output must
both be File.

The <privlist> specification should contain a comma-separated list of simple
privilege names.  For example: 

"owner,dev,rtime"

See intro(2) for more information on privileges.

The <mask> specification can be a comma-separated list of mask specifiers.  Each
specifier can be a CPU number (specified as an integer), a range of CPU numbers in
the form <n>-<m>, or the keyword active, indicating all active CPUs on the sys-
tem.

Configuration File Example 2

The following is an example of the configuration file associated with the scheduler in Fig-
ure 4-3, “Sample Scheduler Window,” on page 4-10.
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Scheduler 2 {
   cycles 8;
   tasks total 10;
   tasks per cycle 10;
   permissions owner=rw;
   distribution RCIM coupled;

   timing source {
      host "buzzard";
      clock "2c2";
      clock duration 10;
      clock count 10000;
   }

   process "/tooth/tutorial/nsim/server1"
         on "papio" {
      NightView False ;
      xterm False ;
      dir "/tooth/tutorial/nsim/" ;
      input File ;
      infile "/dev/null" ;
      output File ;
      outfile "server1.papio.out" ;
      privilege "owner,dev,rtime,tshar,plock,cpubias" ;
      policy F;
      priority 59;
      parameter 1;
      soft overruns 0;
      cpu 0;
      start cycle 0;
      period 8;
   }

   process "/tooth/tutorial/nsim/server2"
         on "buzzard" {
      NightView False ;
      xterm False ;
      dir "/tooth/tutorial/nsim/" ;
      input File ;
      infile "/dev/null" ;
      output File ;
      outfile "server2.buzzard.out" ;
      privilege "owner,dev,rtime,tshar,plock,cpubias" ;
      policy F;
      priority 59;
      parameter 2;
      soft overruns 0;
      cpu 1;
      start cycle 0;
      period 8;
   }

   process "/tooth/tutorial/nsim/server3"
         on "yoshi" {
      NightView False ;
      xterm False ;
      dir "/tooth/tutorial/nsim" ;
      input File ;
      infile "/dev/null" ;
      output File ;
      outfile "server3.yoshi.out" ;
      privilege "owner,dev,rtime,tshar,plock,cpubias" ;
      policy F;
      priority 59;
      parameter 3;
      soft overruns 0;
      cpu active;
      start cycle 0;
      period 1;
   }

}
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Appendix CResources

This appendix details the X resources, NightStar resources, and widget hierarchy in Night-
Sim.

X Resources 3

The following X resources are available for configuring the behavior of NightSim:

*defaultClockRes

Specifies the default resolution in microseconds that is to be used when configuring
a real-time clock. Permissible values are 1, 10, 100, 1000, and 10000. The default
value is 10.

*defaultPermissions

Specifies the default access permissions to be used when creating a new scheduler.
The value is an octal number in the same format used by chmod(1). The default
value is 600.

*defaultUpdateRate

Specifies the default rate in seconds that is to be used for updating the run status
fields in the Scheduler window and taking repetitive queries in the Monitor window.
Minimum value is 0.01 second; maximum value is 100 seconds; default value is 1.0
second.

*defaultMonitorRes

Specifies the default resolution in microseconds of time-based fields in the Monitor
window.  Permissible values are 1, 10, 100, 1000, and 10000; the default value is 1.

*displayTitle1 - *displayTitle9
*displayFields1 - *displayFields9

These resources are used to specify the predefined sets of performance monitor
fields. Up to 9 sets of fields can be defined. The displayTitlen resource is a
string that defines a name for field set n, and the displayFieldsn resource is a
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list of four-letter codes that specify the fields to be displayed. The codes are as fol-
lows:

targ Target system
fpid FPID of the process
spid system PID of the process
name program name
prio program priority
stcy starting cycle
peri period
cpum CPU bias
itrc iteration count
lcyt last cycle time
tott total time
avgt average cycle time
sorc soft overrun count
ovrc overrun count
prcn percent of period used
mnct minimum cycle time
mncf minimum cycle frame
mncc minimum cycle cycle
mnft minimum frame time
mnff minimum frame frame
mxct maximum cycle time
mxcf maximum cycle frame
mxcc maximum cycle cycle
mxft maximum frame time
mxff maximum frame frame
intr inclusion/exclusion of interrupt time

As an example, the following is the default for the first field set:

*displayTitle1:   Summary Fields
*displayFields1:  targ fpid name cpum itrc lcyt tott 
avgt sorc ovrc prcn

*offline

Specifies whether new Scheduler windows should be initially Off-Line (True) or
On-Line (False).  See “On-Line/Off-Line Operation” on page 4-6 for more infor-
mation.

*expert

Specifies whether the user is running in expert mode (True or False).  The default
value is False.

*serverStartTimeout

Specifies the amount of time (in seconds) that NightSim should allow for the Night-
Sim server to start up on a target system.  If the server does not start successfully
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within this time period, but no error is received, NightSim aborts the operation and
displays an error message.

The default value is 15 seconds.  You may need to specify a longer time for slow or
heavily-loaded networks or target systems.

*serverMessageTimeout

Specifies the amount of time (in seconds) that NightSim should allow for the Night-
Sim server to respond to a message.  If the server does not respond within this
period, NightSim will assume that the server has terminated or that the remote target
is inoperative.  NightSim will then abort the operation and display an error message.

The default value is 20 seconds.  You may need to specify a longer time for slow or
heavily-loaded networks or target systems.

*extendedResponseTimeout

Specifies the maximum length of time (in seconds) that NightSim should allow for
the NightSim server to respond with a longer response to a message.  For example,
the length of time NightSim should wait for the NightSim server to read a remote
directory and return the names of all the files contained within.

If the server does not respond within this time period, NightSim will assume that the
server has terminated or that the remote target is inoperative.  NightSim will then
abort the operation and display an error message.

The default value is 90 seconds.  You may need to specify a longer time for slow or
heavily-loaded networks or target systems.

NightStar Resources 3

You may control NightSim's appearance using the NightStar Font Resources and
NightStar Color Resources.  In most cases, however, the default values for the following
resources should be used.

NightStar Font Resources 3

This section describes the special font resources available for NightStar tools.  In addition
to these resources, NightStar tools specify an overall default font that is used for most of
the textual display.  NightStar tools use proportional-width fonts except in areas that
depend on text alignment;  in these instances a fixed-width font is important for
readability.  If you decide to change fonts, make sure that you choose another fixed-width
font for the font resources that have fixed in their names.

NightStar font resources include:

*smallFontList 

Used for areas that require a smaller font.
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*infoFontList 

Used for areas that display informational messages, warnings, errors. 

*fixedFontList 

Used for areas that depend on text alignment.

*smallFixedFontList 

Used for areas that depend on text alignment but require a smaller font.

The /usr/lib/X11/app-defaults/Nsim resource file specifies the font values for
NightSim.

NightStar Color Resources 3

This section describes the special color resources available for NightStar tools.  In
addition to these resources, NightStar tools specify an overall default color that is used
for most of the window areas.  NightStar tools use the same color scheme to indicate that
they are part of the same tool set and to provide cues about the usage of different areas in
the windows.  Each NightStar tool uses a unique color for its menu bars.

The following NightStar color application resources are defined:

*outputBackground
*outputForeground 

Used for the background and foreground colors in output-only areas.

*inputBackground
*inputForeground 

Used for the background and foreground colors in areas that accept user input.

The /usr/lib/X11/app-defaults/Nsim-color resource file specifies the color
values for NightSim.

Widget Hierarchy 3

Information about the widget hierarchy for the graphical user interface is useful for
modifying the behavior of NightSim through the use of standard X11 or Motif resources.
You can get this information by using editres(1).  See the man page for information
about editres.
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active scheduler window

A Scheduler window that is associated with a scheduler that exists on the system.

end–of–cycle scheduling

A form of frequency–based scheduling in which scheduling is triggered when the last
process that is scheduled to execute in the current minor cycle of the current major frame
completes its processing.

expert mode

A mode specified by setting the expert X resource to True, allowing the user to see
more detailed information about the current FBS in the Scheduler window.

FBS

Frequency-based scheduler.

FPID

A unique frequency–based scheduler process identifier that is returned when a program is
scheduled on a frequency–based scheduler.

frame overrun

The condition that occurs when an FBS–scheduled process does not finish its processing
before it is scheduled to run again.

frequency-based scheduler

A high resolution task synchronization mechanism that enables processes to run at user–
specified frequencies.

host system

A system designated by a host name.  A host may be a stand-alone computer system or a
node in a network of computer system connected by ethernet.  See NightSim host, timing
host, target system.

idle time

Time during which the CPU is not busy.
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inactive scheduler window

A Scheduler window that is not associated with an existing scheduler.

iteration

One instance of a process’s being wakened by a frequency–based scheduler. 

KoalaTalk

The inter-tool communication mechanism used by NightSim to exchange messages
among its components.  It is provided with the X Window System.

last time 

A value returned by the performance monitor indicating the amount of time that an FBS–
scheduled process has spent running from the last time that it has been wakened by the
scheduler until it has called fbswait. 

major frame 

One pass through all of the minor cycles with which a frequency–based scheduler is
configured. A major frame has associated with it a duration, which is obtained by
multiplying the duration of a minor cycle by the number of minor cycles per major frame. 

maximum cycle cycle 

A value returned by the performance monitor indicating the number of the minor cycle in
which the maximum cycle time has occurred. 

maximum cycle frame 

A value returned by the performance monitor indicating the number of the major frame in
which the maximum cycle time has occurred. 

maximum cycle time 

A value returned by the performance monitor indicating the greatest amount of time that
an FBS–scheduled process has spent running in a cycle. 

maximum frame frame 

A value returned by the performance monitor indicating the number of the major frame in
which the maximum frame time has occurred. 

maximum frame time 

A value returned by the performance monitor indicating the greatest amount of time that
an FBS–scheduled process has spent running during a major frame. 
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minimum cycle cycle 

A value returned by the performance monitor indicating the number of the minor cycle in
which the minimum cycle time has occurred. 

minimum cycle frame 

A value returned by the performance monitor indicating the number of the major frame in
which the minimum cycle time has occurred. 

minimum cycle time 

A value returned by the performance monitor indicating the least amount of time that an
FBS–scheduled process has spent running in a cycle. 

minimum frame frame 

A value returned by the performance monitor indicating the number of the major frame in
which the minimum frame time has occurred. 

minimum frame time 

A value returned by the performance monitor indicating the least amount of time that an
FBS–scheduled process has spent running during a major frame. 

minor cycle 

The smallest unit of frequency maintained by a frequency–based scheduler. A minor cycle
has associated with it a duration, which is the time that elapses between interrupts
generated by the timing source that is attached to the scheduler. If the timing source is a
real–time clock, the minor cycle duration is defined by specifying the number of clock
counts per minor cycle and the number of microseconds per clock count.

NightSim host

The system from which NightSim was invoked.

NightSim server

The NightSim server is a program that executes on a target system and performs system-
level actions on behalf of NightSim.  Whenever NightSim needs to perform an operation
on a target system, such as creating an FBS, scheduling a program on an FBS, or starting
or stopping an FBS, NightSim makes a request of the NightSim server on that target sys-
tem.  NightSim automatically takes care of starting up a NightSim server on a target sys-
tem when needed.

number of overruns 

A value returned by the performance monitor indicating the number of times that an FBS–
scheduled process has caused a soft or hard frame overrun. 
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performance monitor 

A mechanism that makes it possible to monitor use of the CPU by processes that are
scheduled on a frequency–based scheduler. 

period 

A frequency–based scheduler scheduling parameter that specifies the frequency with
which a specified program is to be wakened in each major frame. A period of one indi-
cates that the program is to be wakened every minor cycle; a period of two indicates that it
is to be wakened once every two minor cycles; and so on.

privilege 

A mechanism through which processes are allowed to perform sensitive operations or
override system restrictions.

process dispatch latency 

The time that elapses from the occurrence of an external event, which is signified by an
interrupt, until the process that is waiting for that external event executes its first
instruction in user mode. 

RCIM

Real-Time Clocks and Interrupt Module - an optional hardware module which provides
both real-time clocks and edge-triggered interrupt pins for the host to which it is attached,
allowing those devices to be used as timing and interrupt sources for that host.  RCIMs
may be connected, and therefore synchronized, via RCIM cables.  RCIM real-time clocks
and edge-triggered interrupts may be used locally or as distributed timing devices.

scheduler key 

A user–supplied numeric identifier for a frequency–based scheduler.

server

See NightSim server.

soft overrun

Soft overruns are a type of frame overrun which give the scheduled process a chance to
recover and return to synchronization.  When scheduling a process, you can specify a con-
secutive soft overrun limit count that this process will tolerate and have processed as soft
overruns by the kernel.  Soft overruns are catastrophic failures only if the process reaches
its limit on the number of soft overruns tolerated.  This soft overrun limit defaults to 0 for
each process. 

starting base cycle 

A frequency–based scheduler scheduling parameter that specifies the first minor cycle in
which an FBS–scheduled process is to be wakened in each major frame.
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target system

Any system on which processes will be scheduled.

timing host

The system on which the timing device physically resides.

timing mode 

The mode under which the performance monitor runs. It specifies whether time spent
servicing interrupts is to be included in or excluded from performance monitor timing
values. 

total iterations 

A value returned by the performance monitor indicating the number of times that an FBS–
scheduled process has been wakened by the scheduler. 

total time 

A value returned by the performance monitor indicating the total amount of time that an
FBS–scheduled process has spent running in all cycles. 

unscheduled process 

A process that is not wakened by the frequency–based scheduler and does not call
fbswait; it is not scheduled to run at a certain frequency. 
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